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Unit I Basic Organization of Computer System : Block diagram & Functions (Central Processing 
Unit, Input/ Output Unit, Storage Unit); Characteristics; Capabilities & Limitations. Types 
of Computing Devices: Desktop, Laptop & Notebook Smart-Phone, Tablet PC, Server, 
Workstation & their Characteristics. Primary Memory & Their Types: RAM, ROM, PROM, 
EPROM, EEPROM,; Cache Memory. PERIPHERAL. DEVICES Input Devices : Keyboard, 
Mouse, Trackball, Joystick, Digitizer or Graphic tablet, Scanners, Digital Camera, Web 
Camera, MICR, OCR, OMR, Bar-Code Reader, Voice Recognition device, Light pen & Touch 
Screen. Output Devices: Display Devices (CRT, TFT, LCD, LED, Multimedia Projectors); 
Video Standard : VGA, SVGA, XGA etc. Impact Printers (Daisy Wheel , Dot Matrix & line 
Printer); Non impact printer (Inkjet, laser, Thermal); 
STORAGE DEVICES magnetic Tape, Cartridge, Data Drives, Hard Disk Drives (Internal & 
External), Floppy Disks, CO, VCD, CD-RW, Zip Drive, DVD, DVD-RW, USB Flash Drive, Blue 
Ray Disc & Memory cards. 

Unit II OPERATING SYSTEM (OS) DOS Basics : FAT, File & Directory Structure and naming rules, 
Booting process, DOS system flies: Internal & External DOS commands. Windows Basics 
(only elementary ides): Windows 7 & 8: Desktop, Control Panel; saving, renaming, 
moving, copying and searching files & folders, restoring from recycle Bin. Creating 
shortcut, Establishing Network Connections. 

Unit III MS Word • Text Editing and formatting using Word 2007 & onwards versions: Creating 
documents using Template; Saving Word file in various file formats; Previewing 
documents, Printing document to file/page; Protecting document; Editing of selected text, 
Inserting, Deleting and Moving text. Formatting documents: page Layout, Paragraph 
format, Aligning text and Paragraph, borders and Shading, Headers and Footers. 

Unit IV MS Power Point & MS Excel • Creating presentation using slide master and template in 
various themes & variants. • Working with slides New slide, move, copy, delete, duplicate, 
slide layouts, presentation views. • Format menu: Font, paragraph, drawing & Editing. • 
Printing presentation: Print slides, notes, handouts and outlines. • Saving presentation in 
different file formats. • Workbook & Worksheet Fundamentals: Concept of Row, Column & 
Cell; Creating a new workbook through blank &template. • Working with worksheet: 
Entering data into worksheet (General , Number, Currency, Date, Time, Text, Accounting, 
etc); Renaming, Copying, Inserting, deleting & protecting worksheet. • Working with Row 
& Column (Inserting, deleting, Pasting, Resizing & Hiding), Cell & Cell formatting, Concept 
of range. 

Unit V Internet and Cyber Security 
Internet: World wide Web, Dial up connectivity, leased line, VSAT, Broad Band, WI-Fl, 
Domain name, Web Browser (internet Explorer, Firefox, Google Chrome, Opera, UC 
Browser, etc. ) Search Engine (Google, Bing, Ask, etc); Website: Static & Dynamic; 
Difference between Website & Portal. • E-mail: Account opening. Sending & Receiving 
Mails, Managing Contacts & Folders. • E-mail, Internet & Social Networking Ethics. • Types 
of viruses & antivirus. • Computer security issues & its protection through firewall & 
antivirus • Making secured online transactions. 
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COMPUTER 

UNIT-I 

 

Computer System is an electronic data processing device which does the following: 
first, Accepts data such as raw facts, figures, and symbol 
then, Processes data into information (Data that is organized, meaningful, and useful ) 
finally, Produces and stores results. 

Information Processing Cycle 

The sequences of events, which make up the information processing cycle, are: 
 Input 
 Processing 
 Output 
 Storage 

 
 
 
 
 
 
 
 
 
 

1. Input—entering data into the computer. 
2. Processing—performing operations on the data. 
3. Storage—saving data, programs, or output for future use. 
4. Output—presenting the results. 

Block diagram of Computer:- 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

1. Input: this is the process of entering data and programs into the computer system. 
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2. Control Unit (CU): The process of input, output, Control Unit (CU): The process of 

input, output, processing and storage is performed under the supervision of a unit called 

'Control Unit'. It decides when to start receiving data, when to stop it, where to store data, 

etc. It takes care of step -by-step processing of all operations inside the computer. 

3. Memory Unit: Computer is used to store data and instructions. 

4. Arithmetic Logic Unit (ALU): The major operations performed by the ALU are addition, 

subtraction, multiplication, division, logic and comparison. 

5. Output: This is the process of producing results from the data for getting useful 

information. 

The ALU and the CU of a computer system are jointly known as the central processing 

unit (CPU). You may call CPU as the brain of any computer system. 

 

History Of Computers 

 Before the 1500s, in Europe, calculations were made 
with an abacus Invented around 500BC, available 
in many cultures (China, Mesopotamia, Japan, 
Greece, Rome, etc.) 

 
 In 1642, Blaise Pascal (French mathematician, physicist, 

philosopher) invented a mechanical calculator called the 
Pascaline 

 

 In 1671, Gottfried von Leibniz (German mathematician, 
philosopher) extended the Pascaline to do 
multiplications, 
divisions, square roots: the Stepped Reckoner 
None of these machines had memory, and they required 
human intervention at each step. 

 
In 1822 Charles Babbage (English mathematician, 
philosopher), sometimes called the “father of 
computing” built the Difference Engine 

 

 Machine designed to automate the computation 
(tabulation) of polynomial functions (which are 
known to be good approximations of many useful 
functions) 

– Based on the “method of finite difference” 
– Implements some storage 

 In 1833 Babbage designed the Analytical Engine, 
but he died before he could build it 
It was built after his death, powered by steam 

 

Computer Generations 
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Generation in computer terminology is a change in technology a computer is/was being 
used. Initially, the generation term was used to distinguish between varying hardware 
technologies. But nowadays, generation includes both hardware and software, which 
together make up an entire computer system. 
There are totally five computer generations known till date. 

 
S.N. Generation & Description 

1 First Generation 
The period of first generation: 1946-1959. Vaccum tube based. 

2 Second Generation 
The period of second generation: 1959-1965. Transistor based. 

3 Third Generation 
The period of third generation: 1965-1971. Integrated Circuit based. 

4 Fourth Generation 
The period of fourth generation: 1971-1980. VLSI microprocessor based. 

5 Fifth Generation 
The period of fifth generation : 1980-onwards.ULSI microprocessor based 

 
First Generation 
The period of first generation was 1946-1959. 
First generation of computer started with using vacuum tubes as the basic components for memory 
and circuitry for CPU(Central Processing Unit). These tubes like electric bulbs produced a lot of heat 
and were prone to frequent fusing of the installations, therefore, were very expensive and could be 
afforded only by very large organizations. 
In this generation mainly batch processing operating system were used. In this generation Punched 
cards, Paper tape, Magnetic tape Input & Output device were used. 
There were Machine code and electric wired board languages used. 

 
The main features of First Generation are: 

Vacuum tube technology 
Unreliable 
Supported Machine language only 
Very costly 
Generate lot of heat 

 
Some computers of this generation were: 

ENIAC 
EDVAC 
UNIVAC 

 
Second Generation 
The period of second generation was 1959-1965. 

Slow Input/Output device 
Huge size 
Need of A.C. 
Non portable 
Consumed lot of electricity 

 

IBM-701 
IBM-650 

This generation using the transistor was cheaper, consumed less power, more compact in size, more 
reliable and faster than the first generation machines made of vacuum tubes. In this generation, 
magnetic cores were used as primary memory and magnetic tape and magnetic disks as secondary 
storage devices. 
In this generation assembly language and high level programming language like FORTRAN, COBOL was 
used. 
There was Batch processing and Multiprogramming Operating system used. 

 
The main features of Second Generation are: 
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Use of transistors 
Reliable as compared to First generation computers 
Smaller size as compared to First generation computers 
Generate less heat as compared to First generation computers 
Consumed less electricity as compared to First generation computers 
Faster than first generation computers 
Still very costly 
A.C. needed 
Support machine and assmebly languages 

 
Some computer of this generation were: 

IBM 1620 
IBM 7094 
CDC 1604 

 
Third Generation 
The period of third generation was 1965-1971. 

CDC 3600 
UNIVAC 1108 

The third generation of computer is marked by the use of Integrated Circuits (IC's) in place of 
transistors. A single I.C has many transistors, resistors and capacitors along with the associated 
circuitry. The I.C was invented by Jack Kilby. This development made computers smaller in size, reliable 
and efficient. 
In this generation Remote processing, Time-sharing, Real-time, Multi-programming Operating System 
were used. 
High level language (FORTRAN-II TO IV, COBOL, PASCAL PL/1, BASIC, ALGOL-68 etc.) were used during 
this generation. 

 
The main features of Third Generation are: 

IC used 
More reliable 
Smaller size 
Generate less heat 
Faster 

 
Some computer of this generation were: 

IBM-360 series 
Honeywell-6000 series 
PDP(Personal Data Processor) 

 
Fourth Generation 
The period of Fourth Generation was 1971-1980. 

Lesser maintenance 
Still costly 

 needed 
Consumed lesser electricity 
Support high level language 

 

IBM-370/168 
TDC-316 

The fourth generation of computers is marked by the use of Very Large Scale Integrated (VLSI) 
circuits.VLSI circuits having about 5000 transistors and other circuit elements and their associated 
circuits on a single chip made it possible to have microcomputers of fourth generation. Fourth 
Generation computers became more powerful, compact, reliable, and affordable. As a result, it gave rise 
to personal computer (PC) revolution. 
In this generation Time sharing, Real time, Networks, Distributed Operating System were used. 
All the Higher level languages like C and C++, DBASE etc. were used in this generation. 

 
The main features of Fourth Generation are: 
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VLSI technology used 
Very cheap 
Portable and reliable 
Use of PC's 
Very small size 
Pipeline processing 
No A.C. needed 
Concept of internet was introduced 
Great developments in the fields of networks 
Computers became easily available 

 
Some computer of this generation were: 

DEC 10 
STAR 1000 
PDP 11 
CRAY-1(Super Computer) 
CRAY-X-MP(Super Computer) 

 

Fifth Generation 
The period of Fifth Generation is 1980-till date. 
In the fifth generation, the VLSI technology became ULSI (Ultra Large Scale Integration) technology, 
resulting in the production of microprocessor chips having ten million electronic components. 
This generation is based on parallel processing hardware and AI (Artificial Intelligence) software. 
AI is an emerging branch in computer science, which interprets means and method of making 
computers think like human beings. 
All the Higher level languages like C and C++, Java, .Net etc. are used in this generation. 
AI includes: 

Robotics 
Neural networks 
Game Playing 
Development of expert systems to make decisions in real life situations. 
Natural language understanding. 

 
The main features of Fifth Generation are: 

ULSI technology 
Development of true artificial intelligence 
Development of Natural language processing 
Advancement in Parallel Processing 
Advancement in Superconductor technology 
More user friendly interfaces with multimedia features 
Availability of very powerful and compact computers at cheaper rates 

 
Types of Computer 
Some computer types of this generation are: 

 

 Desktop 
 Laptop 
 NoteBook 
 UltraBook 
 ChromeBook 
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Computer can be broadly classified by their speed and computing power. 
 

 

Sr. 
No. 

Type Specifications 

1 PC (Personal 
Computer) 

Single user computer system. Moderately powerful 
microprocessor. 

2 WorkStation Single user computer system. Similar to Personal Computer 
but have more powerful microprocessor. 

3 Mini Computer Multi-user computer system. Capable of supporting hundreds 
of users simulaneously. 

4 Main Frame Multi-user computer system. Capable of supporting hundreds 
of users simulaneously.Software technology is different from 
minicomputer. 

5 Supercomputer An extremely fast computer which can perform hundreds of 
millions of instructions per second. 

 

PC (Personal Computer) 
 

 A PC can be defined as a small, relatively inexpensive 
computer designed for an individual user. 

 PCs are based on the microprocessor technology that 
enables manufacturers to put an entire CPU on one chip. 

 Businesses use personal computers for word processing, 
accounting, desktop publishing, and for running 
spreadsheet and database management applications. 

 At home, the most popular use for personal computers is for 
playing games and surfing the Internet. 

 Although personal computers are designed as single-user systems, these systems are normally 
linked together to form a network. 

 In terms of power, now-a-days High-end models of the Macintosh and PC offer the same 
computing power and graphics capability as low-end workstations by Sun Microsystems, 
Hewlett-Packard, and DELL. 

 

WorkStation 
 Workstation is a computer used for engineering 

applications (CAD/CAM), desktop publishing, software 
development. 

 They require a moderate amount of computing power and 
relatively high quality graphics capabilities. 

 Workstations generally come with a large, high-resolution 
graphics screen, large amount of RAM, inbuilt network 
support, and a graphical user interface. 

 Most workstations also have a mass storage device such as a 
disk drive, but a special type of workstation, called a 
diskless workstation, comes without a disk drive. 

 Common operating systems for workstations are UNIX and Windows NT. 
 Like PC, Workstations are also single-user computers. 
 workstations are typically linked together to form a local-area network, although they can also 

be used as stand-alone systems. 
 

Minicomputer 
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 It is a midsize computer. 
 A minicomputer is a multi-processing system capable of supporting from up to 250 users 

simultaneously. 

 

Mainframe 
 

 Mainframe is a very large in size and is an expensive 
computer capable of supporting hundreds, or even 
thousands, of users simultaneously. 

 Mainframe executes many programs concurrently. 
 Mainframes support many simultaneous programs execution. 

 
Supercomputer 

 Supercomputers are one of the fastest computers 
currently available. 

 Supercomputers are very expensive and are 
employed for specialized applications that require 
immense amounts of mathematical calculations 
(number crunching). 

 For example, weather forecasting , scientific 
simulations, (animated) graphics, fluid dynamic 
calculations, nuclear energy research, electronic 
design, and analysis of geological data (e.g. in 
petrochemical prospecting). 

 

 
All types of computer follows a same basic logical structure and perform the following five basic 
operations for converting raw input data into information useful to their users 

 
Sr. No. Operation Description 

1 Take Input The process of entering data and instructions into the computer 
system. 

2 Store Data Saving data and instructions so that they are available for processing 
as and when required. 

3 Processing Data Performing arithmetic , logical operations on data in order to convert 
them into useful information. 

4 Output Information The process of producing useful information or results for the 
user,such as a printed report or visual display. 

5 Control the 
workflow 

Direct the manner and sequence in which all of the above operations 
are performed. 

 
 

Basic components of a computer system 
 Input Unit
 Output Unit
 Storage Unit
 Central Processing Unit (CPU)
 Arithmetic and Logic Unit (ALU)
 Control Unit
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Input Unit 
This unit contains devices with the help of which we enter data into computer. This unit makes link 
between user and computer. 
The input devices translate the human being information into the form understandable by computer. 

 

CPU (Central Processing Unit) 
 CPU is considered as the brain of the computer. 
 CPU performs all types of data processing operations. 
 It stores data , intermediate results and instructions(program) 
 .It controls the operation of all parts of computer. 
 Converts data into information 
 Control center 
 Set of electronic circuitry that executes stored program instructions 
 Two parts 

o Control Unit (CU) 
 Part of the hardware that is in-charge 
 Directs the computer system to execute stored program instructions 
 Communicates with other parts of the hardware 

 
o Arithmetic Logic Unit (ALU) 

 Performs arithmetic operations 
 

 Performs logical operations 
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RAM 
 A RAM constitutes the internal memory of the CPU for storing data, program and program 

result. 
 It is read/write memory. 
 It is called random access memory (RAM). 
 RAM is volatile, i.e. data stored in it is lost when we 

switch off the computer or if there is a power failure. 
 RAM is small , both in terms of its physical size and in 

the amount of data it can hold. 
 Hence a backup uninterruptible power system(UPS) is 

often used with computers 
 Keeps the instructions and data for current program 
 Data in memory can be accessed randomly 
 Easy and speedy access 
 Volatile 
 Erased 
 Written over 

 
Types of RAM 

 Static RAM (SRAM)
 Dynamic RAM (DRAM)

 
Static RAM (SRAM) 

 
 The word static indicates that the memory retains its contents as long as power remains 

applied. 
 Data is lost when the power gets down due to volatile nature. 
 SRAM chips use a matrix of 6-transistors and no capacitors. 
 Transistors do not require power to prevent leakage, so SRAM need not have to be refreshed on 

a regular basis. 
 Because of the extra space in the matrix, SRAM uses more chips than DRAM for the same 

amount of storage space, thus making the manufacturing costs higher. 
 Static RAM is used as cache memory needs to be very fast and small. 

 
Characteristic of the Static RAM 

 It has long data lifetime 
 There is no need to refresh 
 Faster 
 Used as cache memory 
 Large size 
 Expensive 
 High power consumption 

 
Dynamic RAM (DRAM) 

 DRAM must be continually refreshed in order to maintain the data. 
 This is done by placing the memory on a refresh circuit that rewrites the data several hundred 

times per second. 
 DRAM is used for most system memory because it is cheap and small. 
 All DRAMs are made up of memory cells. 
 These cells are composed of one capacitor and one transistor. 
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Characteristic of the Dynamic RAM 
 It has short data lifetime 
 Need to refresh continuously 
 Slower as compared to SRAM 
 Used as RAM 
 lesser in size 
 Less expensive 
 Less power consumption 

 

ROM 
 ROM stands for Read Only Memory. 
 We can only read but cannot write on it. 
 This type of memory is non-volatile. 
 The information is stored permanently in such 

memories during manufacture. 
 A ROM, stores such instruction as are required to 

start computer when electricity is first turned on, 
this operation is referred to as bootstrap. 

 ROM chip are not only used in the computer but 
also in other electronic items like washing machine and microwave oven. 

 

Types of ROM 
 

 MROM (Masked ROM)
 The very first ROMs were hard-wired devices that contained a pre-programmed set of data or 

instructions. 
 These kinds of ROMs are known as masked ROMs. 
 It is inexpensive ROM. 

 

 PROM (Programmable Read only Memory)
 PROM is read-only memory that can be modified only once by a user. 
 The user buys a blank PROM and enters the desired contents using a PROM programmer. 
 Inside the PROM chip there are small fuses which are burnt open during programming. 
 It can be programmed only once . 
 It is not erasable. 

 
 EPROM(Erasable and Programmable Read Only Memory)
 The EPROM can be erased by exposing it to ultra-violet light for duration of up to 40 minutes. 
 During programming an electrical charge is trapped in an insulated gate region. 
 The charge is retained for more than ten years because the charge has no leakage path. 
 For erasing this charge, ultra-violet light is passed through a quartz crystal window (lid). 
 This exposure to ultra-violet light dissipates the charge. 
 During normal use the quartz lid is sealed with a sticker. 

 
 EEPROM(Electrically Erasable and Programmable Read Only Memory)
 The EEPROM is programmed and erased electrically. 
 It can be erased and reprogrammed about ten thousand times. 
 Both erasing and programming take about 4 to 10 ms (milli second). 
 In EEPROM, any location can be selectively erased and programmed. 
 EEPROMs can be erased one byte at a time, rather than erasing the entire chip. 
 Hence, the process of re-programming is flexible but slow. 
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Advantages of ROM 
 Non-volatile in nature
 These cannot be accidentally changed

 Cheaper than RAMs
 Easy to test
 More Reliable than RAMs
 These are static and do not require refreshing

 Its contents are always known and can be verified

 
Output Unit 
Any machine which is capable of representing information from a computer is known as output device. 
Output unit consists of devices with the help of which we get the information from computer. This unit 
is a link between computer and users. 
Output devices translate the computer's output into the form understandable by users. 

 
Following are few of the important output devices which are used in Computer Systems 

 Monitors 
 Graphic Plotter 
 Printer 

 Monitors 
 Sound card 
 speaker 

 

Monitor commonly called as Visual Display Unit (VDU) is the main output device of a computer. It 
forms images from tiny dots, called pixels that are arranged in a rectangular form. The sharpness of the 
image depends upon the no. of the pixels. 
There are two kinds of viewing screen used for monitors. 
Cathode-Ray Tube (CRT) 
Flat- Panel Display 

 
Cathode-Ray Tube (CRT) Monitor 
In the CRT display is made up of small picture elements called pixels for short. The smaller the pixels, 
the better the image clarity, or resolution. It takes more than one illuminated pixel to form whole 
character, such as the letter e in the word help. 
A finite number of characters can be displayed on a screen at once. The screen can be divided into a 
series of character boxes - fixed location on the screen where a standard character can be placed. 
The most screens are capable of displaying 80 characters of data horizontally and 25 lines vertically. 
There are some disadvantages of CRT 

 Large in Size
 High Power consumption

 
Flat-Panel Display Monitor 
The flat-panel display refers to a class of video devices that have reduced volume, weight and power 
requirement compare to the CRT. You can hang them on walls or wear them on your wrists. Current 
uses for flat-panel displays include calculators, videogames, monitors, laptop computer, graphics 
display. 

 
The flat-panel display are divided into two categories 
Emissive Displays - The emissive displays are devices that convert electrical energy into light. 
Example are plasma panel and LED(Light-Emitting Diodes). 
Non-Emissive Displays - The Non-emissive displays use optical effects to convert sunlight or light 
from some other source into graphics patterns. Example is LCD(Liquid-Crystal Device) 

 
Printers 
Printer is the most important output device, which is used to print information on paper. 
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There are two types of printers 
 Impact Printers 
 Non-Impact Printers 

 
Impact Printers 
The printers that print the characters by striking against the ribbon and onto the paper are called 
impact printers. 
Characteristics of Impact Printers are following 

 Very low consumable costs
 Impact printers are very noisy

 Useful for bulk printing due to low cost
 There is physical contact with the paper to produce an image

 
These printers are of two types 

 Character printers
 Line printers

 
Character Printers: 
Character Printers are printers which print one character at a time. 
These are of further two types 

 Dot Matrix Printer(DMP)
 Daisy Wheel

 
Dot Matrix Printer 
In the market one of the most popular printer is Dot Matrix Printer because of their ease of printing 
features and economical price. Each character printed is in form of pattern of Dot's and head consists of 
a Matrix of Pins of size (5*7, 7*9, 9*7 or 9*9) which comes out to form a character that is why it is called 
Dot Matrix Printer. 

 
Advantages 

 Inexpensive
 Widely Used

 Other language characters can be printed

 
Disadvantages 

 Slow Speed

 Poor Quality

 
Daisy Wheel Printer 
Head is lying on a wheel and Pins corresponding to characters are like petals of Daisy(flower name) 
that is why it is called Daisy Wheel Printer. These printers are generally used for word-processing in 
offices which require a few letters to be send here and there with very nice quality representation. 

 
Advantages 

 More reliable than DMP's
 Better quality

 The fonts of character can be easily changed.
 

Disadvantages 
 Slower than DMP's
 Noisy
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 More expensive than DMP's
 

Line Printers 
Line printers are printers which print one line at a time. 
These are of further two types 

 Drum Printer
 Chain Printer

Drum Printer 
This printer is like a drum in shape so it called drum printer. The surface of drum is divided into 
number of tracks. Total tracks are equal to size of paper i.e. for a paper width of 132 characters, Drum 
will have 132 tracks. A character set is embossed on track. The different characters sets are available in 
market 48 character set, 64 and 96 characters set. One rotation of drum prints one line. Drum Printers 
are fast in speed and speed in between 300 to 2000 lines per minute. 
Advantages 

 Very high speed

Disadvantages 
 Very expensive
 Characters fonts cannot be changed

 
Chain Printer 
In this printer chain of character sets are used so it called Chain Printers. A standard character set may 
have 48, 64, 96 characters. 
Advantages 

 Character fonts can easily be changed.
 Different languages can be used with the same printer.

Disadvantages 
 Noisy

 Do not have the ability to print any shape of characters.
 

Non-impact Printers 
The printers that print the characters without striking against the ribbon and onto the paper are called 
Non-impact Printers. These printers print a complete page at a time, also called as Page Printers. 
These printers are of two types 

 Laser Printers 
 Inkjet Printers 

Characteristics of Non-impact Printers 
 Faster than impact printers.
 They are not noisy.
 High quality.
 Support many fonts and different character size.

 
Laser Printers 
These are non-impact page printers. They use laser lights to produces the dots needed to form the 
characters to be printed on a page. 
Advantages 

 Very high speed.
 Very high quality output.
 Give good graphics quality.
 Support many fonts and different character size.

Disadvantage 
 Expensive.
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 Cannot be used to produce multiple copies of a document in a single printing.
 

Inkjet Printers 
Inkjet printers are non-impact character printers based on a relatively new technology. They print 
characters by spraying small drops of ink onto paper. Inkjet printers produce high quality output with 
presentable features. 
They make less noise because no hammering is done and these have many styles of printing modes 
available. Colour printing is also possible. Some models of Inkjet printers can produce multiple copies 
of printing also. 
Advantages 

 High quality printing
 More reliable

Disadvantages 
 Expensive as cost per page is high

 Slow as compare to laser printer
 

Sound card:- 
A sound card (also known as an audio card) is an internal computer expansion card that facilitates the 
input and output of audio signals to and from a computer under control of computer programs. The 
term sound card is also applied to external audio interfaces that use software to generate sound, as 
opposed to using hardware inside the PC. Typical uses of sound cards include providing the audio 
component for multimedia applications such as music composition, editing video or audio, 
presentation, education and entertainment (games) and video projection. 
Computers also produce sound output, ranging from simple beeps alerting the user, to impressive game 
sound effects, to concert quality music. The circuitry to produce sound may be included on the 
motherboard, but high quality audio output from a PC usually requires a sound card in one of the 
expansion slots, connected to a set of good quality external speakers or headphones. 

 
Multimedia is a term describing computer output that includes sound, text, graphics, movies, and 
animation. A sound card is an example of a multimedia output device (as is a monitor that can display 
graphics). 

 
Speaker 
A speaker gives you sound output from your computer. Some speakers are built into the computer and 
some are separate. 

 
Input devices:- 
Following are few of the important input devices which are used in Computer Systems 

 Keyboard 
 Mouse 
 Joy Stick 
 Light pen 
 Track Ball 
 Scanner 
 Graphic Tablet 
 Microphone 
 Magnetic Ink Card 

Reader(MICR) 
 Optical Character 

Reader(OCR) 
 Bar Code Reader 
 Optical Mark Reader 

 Touch screen 
 Digital camera 
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Keyboard 
Most common and very popular input device is keyboard. The keyboard helps in inputting the data to 
the computer.The layout of the keyboard is like that of traditional typewriter, although there are some 
additional keys provided for performing some additional functions. 
Keyboard are of two sizes 84 keys or 101/102 keys, but now 104 keys or 108 keys keyboard is also 
available for Windows and Internet. 

 
The keys are following 

Sr. 
No. 

Keys Description 

1 Typing Keys 
These keys include the letter keys (A-Z) and digits keys (0-9) which are 
generally give same layout as that of typewriters. 

 
2 

 
Numeric Keypad 

It is used to enter numeric data or cursor movement. Generally, it 
consists of a set of 17 keys that are laid out in the same configuration 
used by most adding machine and calculators. 

 
3 

 
Function Keys 

The twelve functions keys are present on the keyboard. These are 
arranged in a row along the top of the keyboard.Each function key has 
unique meaning and is used for some specific purpose. 

 
4 

 
Control keys 

These keys provides cursor and screen control. It includes four 
directional arrow key.Control keys also include Home, End,Insert, 
Delete, Page Up, Page Down, Control(Ctrl), Alternate(Alt), Escape(Esc). 

5 
Special Purpose 
Keys 

Keyboard also contains some special purpose keys such as Enter, Shift, 
Caps Lock, Num Lock, Space bar, Tab, and Print Screen. 

 
Mouse 
Mouse is most popular Pointing device. It is a very famous cursor-control device. It is a small palm size 
box with a round ball at its base which senses the movement of mouse and sends corresponding signals 
to CPU on pressing the buttons. 
Generally it has two buttons called left and right button and scroll bar is present at the mid. Mouse can 
be used to control the position of cursor on screen, but it cannot be used to enter text into the 
computer. 

 
ADVANTAGES 

 Easy to use
 Not very expensive
 Moves the cursor faster than the arrow keys of keyboard.

 
Joystick 
Joystick is also a pointing device which is used to move cursor position on a monitor screen. It is a stick 
having a spherical ball at its both lower and upper ends. The lower spherical ball moves in a 
socket.TheJoystic can be moved in all four directions. 
The function of joystic is similar to that of a mouse. It is mainly used in Computer Aided 
Designing(CAD) and playing computer games. 

 
Light Pen 
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Light pen is a pointing device which is similar to a pen. It is used to select a displayed menu item or 
draw pictures on the monitor screen.It consists of a photocell and an optical system placed in a small 
tube. 
When light pen's tip is moved over the monitor screen and pen button is pressed, its photocell sensing 
element detects the screen location and sends the corresponding signal to the CPU. 

 
Track Ball 
Track ball is an input device that is mostly used in notebook or laptop computer, instead of a mouse. 
This is a ball which is half inserted and by moving fingers on ball, pointer can be moved. 
Since the whole device is not moved, a track ball requires less space than a mouse. A track ball comes in 
various shapes like a ball, a button and a square. 

 
Scanner 
Scanner is an input device which works more like a photocopy machine. It is used when some 
information is available on a paper and it is to be transferred to the hard disc of the computer for 
further manipulation. 
Scanner captures images from the source which are then converted into the digital form that can be 
stored on the disc. These images can be edited before they are printed. 

 
Digitizer 
Digitizer is an input device which converts analog information into a digital form. Digitizer can convert 
a signal from the television camera into a series of numbers that could be stored in a computer. They 
can be used by the computer to create a picture of whatever the camera had been pointed at. 
Digitizer is also known as Tablet or Graphics Tablet because it converts graphics and pictorial data into 
binary inputs. A graphic tablet as digitizer is used for doing fine works of drawing and images 
manipulation applications. 

 
Microphone 
Microphone is an input device to input sound that is then stored in digital form. The microphone is used 
for various applications like adding sound to a multimedia presentation or for mixing music. 

 
Magnetic Ink Card Reader(MICR) 
MICR input device is generally used in banks because of a large number of cheques to be processed 
every day. The bank's code number and cheque number are printed on the cheques with a special type 
of ink that contains particles of magnetic material that are machine readable. 
This reading process is called Magnetic Ink Character Recognition(MICR). The main advantages of MICR 
is that it is fast and less error prone. 

 
Optical Character Reader(OCR) 
OCR is an input device used to read a printed text. OCR scans text optically character by character, 
converts them into a machine readable code and stores the text on the system memory. 

 
Bar Code Readers 
Bar Code Reader is a device used for reading bar coded data (data in form of light and dark lines). Bar 
coded data is generally used in labelling goods, numbering the books etc. It may be a hand held scanner 
or may be embedded in a stationary scanner. 
Bar Code Reader scans a bar code image, converts it into an alphanumeric value which is then fed to the 
computer to which bar code reader is connected. 

 
Optical Mark Reader(OMR) 
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OMR is a special type of optical scanner used to recognize the type of mark made by pen or pencil. It is 
used where one out of a few alternatives is to be selected and marked. It is specially used for checking 
the answer sheets of examinations having multiple choice questions. 

 
Touch screen 
Some computers, especially small hand-held PDAs, have touch sensitive display screens. The user can 
make choices and press button images on the screen. You often use a stylus, which you hold like a pen, 
to “write” on the surface of a small touch screen. 

 
Digital camera 
A digital camera can store many more pictures than an ordinary camera. Pictures taken using a digital 
camera are stored inside its memory and can be transferred to a computer by connecting the camera to 
it. A digital camera takes pictures by converting the light passing through the lens at the front into a 
digital image. 

 

Storage Devices 
The memory is of two types; one is the primary memory and the other one is the secondary 
memory. 

 
The primary memory is the volatile memory and the secondary memory is the non volatile memory. 
The volatile memory is the kind of the memory that is erasable and the non volatile memory is the one 
where in the contents cannot be erased. Basically when we talk about the data storage devices it is 
generally assumed to be the secondary memory. 

 
The secondary memory is used to store the data permanently in the computer. The secondary storage 
devices are usually as follows: hard disk drives – this is the most common type of storage device that is 
used in almost all the computer systems. The other ones include the floppy disk drives, the CD ROM, 
and the DVD ROM. The flash memory, the USB data card etc. 
As we know that the Main Memory Stores the data in a Temporary Manner means all the data will be 
loss when the Power switched off. And all the data will be loss when the power goes switched off. 
So that we uses the Secondary Storage devices those are used for Storing the data in a Permanent 
Manner means all the Data will remain Stored whether the Power is Switched on or Switched off means 
the Power Will never effect on the System. For storing the data in a Permanent Manner we uses the 
Magnetic Storage Devices. 

 
There are also Some Advantages of Secondary Storage Devices:- 
1) Non-Volatile Storage Devices: The Non-Volatile Storage Devices are Non-Volatile in the nature 
means them never loss their data when the Power goes switched off. So that data which is Stored into 
the Non-Volatile Storage Devices will never be Loosed When the Power Switched off. 
2) Mass Storage: The Capacity of these Devices is very high means we can Store the Huge Amount of 
data into the Secondary Storage Devices. We can Store data into the Secondary Storage Devices in the 
form of Giga Bytes and Tera Bytes. 
3) Cost Effective: The Cost of Secondary Storage Devices is very lower in compare to the Main Memory 
So that they are also called as the more cost effective and they are very small and couldn’t easily 
damage. And the data can’t be easily loss from these Disks. 
4) Reusability: As Memory Contains the Data in the Temporary as well as Permanent Manner. But the 
Secondary Storage Devices are always Reusable means they can be erased and stored any Time. Means 
we can add or Remove the Contents from these Disks when we Requires. 

 
Various types of Secondary Storage Devices are as Followings: - 
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1) Magnetic Tapes: The Magnetic Tapes is the Type of Secondary Storage Device and this Device is 
used for taking back up of data and this Tape contains some magnetic fields and the Magnetic Tapes are 
used Accessing the data into the Sequential Form and the Tape Also Contains a Ribbon which is coated 
on the Single Side of the Tape and also contains a head which reads the data which is Recorded on to 
the Tape. And when we are reading the information from the disk then we can also read backward 
information means we can also back the Tape for Reading the Previous information. And For inserting 
the Tape into the System we also Requires Some Tape Drives Which Contains Tape and which is 
Responsible for Reading the contents from the Tapes. 
They can Store huge Amount of data into the Tape Drive , But the Main Limitation of the Tape Drive is 
that we cant Access the Data from the Disks directly means if we wants to 100th Record from the Tape 
then we must have to move all the Previous i.e. 99th Records first. And the Tapes are also easily 
damaged due to the Human Errors. 
2) Magnetic Disks : - This is also called as the hard disk and this is made from the thin metal platter 
which is coated on the both sides of the magnetic Disks. And the there are Many Plates or Platters into a 
single Hard Disk and all the Plates are Made from the Magnetic Materials and all the Disks are Rotate 
from the 700 to 3600 rpm means Rotation per Minute and the Hard Disk also Contains a head which is 
used for both Reading and Writing the Data from the Hard Disks. 
The Plate of Disk is divided into the Tracks and sectors and the collection of Tracks makes a Cylinder 
means all the Tracks of the Disk which a Consecutive Areas makes a Cylinder. 
The Disk is first divided into the Number of Tracks and the Tracks are further divided into the sectors 
and the Number of Tracks Makes a Cylinder. All the data is Stored into the disk by using Some Sectors 
and each sectors belongs to a Tracks. 
The Data is accessed from the Disk by using the heads, all the heads have Some Arm those are used for 
Reading the Data from the Particular Tracks and sector. When the Disk Rotates very high Speed then 
the Head also Moves, For Reading the data from the Disk the ARM touches with the Particular Track 
and read the data from that Location. 
For Locating a Particular data from the Disk the head Moves Around the Disk very quickly and data 
which a user wants to Access must have an Address So that Arm of the head just use that Address 
Means the Number of Cylinder, Number of Track and Number of Sectors from which user wants to read 
the data. With the Help of these Read and Write heads we can also Read the Data from the Disk and we 
can also Stores some data onto the Disk. Some Time Considerations are also used when we are 
accessing or storing the data onto the hard disk. 
1) Seek Time: - The Total Time which is Taken to Move on the Desired track is known as the seek 
Time. And time is always measured by using the Milliseconds. 
2) Latency Time. : The time required to Bring the Particular Track to the Desired Location Means the 
Total Time to bring the Correct the Sector for Reading or for the read and Write head. This is also called 
as the Average Time. 
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3) Data Transfer Time: The Total Time which is required for Reading and Writing the data into the 
Disk is known as the Data transfer Time. 

 
3) Floppy Diskette: The Floppy Disk is also a Secondary Storage device which is used for storing the 
data in a Permanent Manner. 
The floppy is made up of Rigid Mylar Plastic and also contains a Magnetic black disk inside the Plastic 
Cover. The Floppy Disk also Stores all the Data into the Form of Tracks and Sectors and the floppy Disk 
provides both Reading and Writing the data into the Disk. The Floppy Disk is also called as Reusable 
Disk means the Floppy Disk Provides us the Facility to Read and Writes the Data into disk as and When 
Necessary and Also Many Times. We can Read and Write the data from the Disk. 
The Main Advantage of the Floppy Disk is that the Data can be Stored many Times but the Main 
Limitation of the floppy Disk is that floppy Disk have a Small capacity and the Floppy Disk  also 
doesn’t have Reliability means the Data Stored into the Disk may not be used for Long Time because 
the floppy Disk is very Sensitive Thing when we Move the Head of the Disk Again and Again then the 
floppy disk gets Damaged. So that we can say that Floppy Disk is not a Reliable thing. And I the Other 
side the Cost of floppy Disk is also high means with the Comparison of the Other Storage Media’s Floppy 
Disk have some more cost. 
4) Optical Disks: The Optical Disks are also called as the CD-ROM’s means Compact Disk Read Only 
Memory which is also used for Storing the data into the Disk and this is called as the Optical Disk 
because the CD-ROM ‘s are made up of the Golden or Aluminum Material and the data is Stored on the 
Disk in the Form of the Tracks and Sectors. The Whole Disk is Divided into the Number of Tracks and 
the Single Track is Divided into the Number of Sectors and the Data is Stored into the Sectors and the 
Disk is Divided into the Sectors as the first Track Contains the Sectors in the huge Size and the Other 
Tracks contains the Sectors in a Small Manner. So that as the Disk grows the Disk is Divided into the 
Small Number of Tracks and the Sectors. 
CD-ROM Contains the data Which is truly Read able means we cant edit the contents of the CD-ROM 
Means once Data has been Written into the CD , we can be able to Change the Contents of the Disk and 
the Data which is Stored on the Disk can be Any Time Read by the user. 
The CD-ROM provides us the Large Capacity in compare to the Floppy Disks and the CDROM can Store 
the Data from 650 MB to 800 MB means the data can be Store up to this Space. 
There are Many Disks that can’t be Erased once Written So they are also called as the WORM Disks 
Means the Write Once and Read Many Mane a user can just Write the data only one Time and then after 
that he can use that Disk Many Times but a user cant Edit or Change those Contents after they are 
Written into the File. 
So that these Types of Optical Disks are also called as the CD-ROM and also Some Times they  are 
known as the CD-R Means the Read Only Disks because the data which is Written into these Types of 
Disks is never to be Erased. 
Now these Days there are also Some CDs Available those are also called as the CD-RW or Read Writable 
Disks. As the Name Suggest these Disks Provides the feature to the user to Read and Write the Contents 
from the Disk as they feel Necessary So that the CD-RW are now Most Popular because a user can any 
Time Remove the Contents from the Disk and also he can store the new Contents into the Disk. 
The CD-R and CD-RW both have Same Capacity and both these can be used for Transferring the Files 
from one System to another but the Main difference is that the cost. The CD-RW has Some More Cost in 
compare to the Simple CD or in Compare to the CD-R. 
Winchester Disk 
Another term for hard disk drive. The term Winchester comes from an early type of disk drive 
developed by IBM that had 30MB of fixed storage and 30MB of removable storage; so its inventors 
called it a Winchester in honor of its 30/30 rifle. Although modern disk drives are faster and hold more 
data, the basic technology is the same, so Winchester has become synonymous with hard. 
Zip disk 
A Zip disk is similar in size to a floppy diskette, but thicker. It is basically a “super floppy” but the 
higher construction tolerances and smaller read/write heads allow the Zip disk to hold more data than 
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a floppy. The first Zip disks held 100 MB. Later Zip drives could read 250 MB Zips (in addition to the old 
100 MB disks). An even newer model Zip drive uses 750 MB disks. 
Both Zip disk and floppy diskettes have the advantage of being removable media. Data stored on these 
disks can be removed and taken to other locations. Both Zips and floppies can be formatted for either 
the PC or the Macintosh (Macs can read both formats). 
We had Zip drives in our previous PCs and Macs at UNM-LA, but our newer computers don't use these, 
so you may never have to deal with them. 
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Unit II 
Operating system: 

 

The Operating System of a computer can be defined as a collection of software modules which extend 
the computer hardware and make it more convenient and easier to use for other programs. In other 
words it "converts" real computer with hardware resources into a virtual machine with virtual 
resources. 

 
Therefore, all software may be divided into two broad categories: 
System Software, which runs on hardware resources (e.g. MacOS, Windows) and User Software, 
which runs on virtual resources provided by operating system (e.g. MS Word, Adobe Photoshop). Every 
computer needs to have operating system in order to run any end-user application. 

 
An Operating System is a set of programs that controls and coordinates the use of computer hardware 
among various application programs. It provides an environment within which user can execute 
programs. A computer can be divided into four components: the hardware, the operating system, the 
applications programs, the users. It is the operating system that manages all the above components. 
The various functions of the operating system are: 

 Controlling Input/Output devices (Keyboard, Mouse, Monitor, Printer, Plotter etc...)
 Booting the computer
 Memory and File storage management
 CPU Scheduling and controlling processes
 Loading, initiating, executing and supervising user applications programs
 Handling errors and restarting

 Providing command interface between user and computer system

Examples of Operating system are : UNIX (Solaris, IRIX, HPUnix, Linux, DEC Unix) Microsoft Disk 
Operating System (MS-DOS), WIN95/98, WIN NT, OS/2 etc. 

 
An operating system is a group of computer programs that coordinates all the activities among 
computer hardware devices. It is the first program loaded into the computer by a boot program and 
remains in memory at all times. 

 
Types of Operating Systems 
Within the broad family of operating systems, there are generally four types, categorized based on the 
types of computers they control and the sort of applications they support. The categories are: 

 Real-time operating system(RTOS)
 Single-user, single task

 Single-user, multi-tasking
Multi-user 
The system administrator is the only "user" for Windows 2000 or Netware. The network support and 
all of the remote user logins the network enables are, in the overall plan of the operating system, a 
program being run by the administrative user. 
Difference between windows and DOS 

 DOS Windows 

Definition DOS (Disk Operating System) are 
simple text command operating 
systems that were popular from  
1981 to 1995. 

Windows is a range of graphical interface 
operating systems that are developed and 
sold by Microsoft. 

GUI DOS used a text based interface that Windows uses graphics, images and text. 
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 required text and codes to operate  

Input System Text is used as the basic input system 
commands. 

Uses a mouse for all operating system input. 

Multitasking DOS is unable to run multiple 
processes at the same time. 

Windows is a multitasking operating 
system; allowing more than one process to 
work simultaneously. 

Storage Size The highest amount of storage size 
available is 2GB. 

Window systems offer storage space up to 2 
terabyte. 

Demands on 
System 
Resources 

Booting up system is DOS is less 
demanding on the CPU. 

Booting up Windows is more demanding on 
the CPU. 

Registry and 
Swap Files 

DOS uses a directory system, where 
all the files are contained within a 
particular directory or a 
subdirectory. 

Windows uses a different registry compared 
to DOS, making it difficult to manually delete 
programs. An excessive number of 
temporary files and file fragments can cause 
the system to slow down or crash. 

Current Uses More ideally used for prototyping, 
testing, and making automated 
systems. 

Used worldwide as the most popular 
operating system. 

Price DOS is free Windows is costly 

 
 

Computers have changed a great deal since the introduction of the first version of MS-DOS in 1981. 
While MS-DOS was the dominant operating system in the world of computers for several years, 
graphical user interfaces (GUIs) eventually became the norm, and today Windows runs on the majority 
of the world's computers. Comparing standalone versions of MS-DOS with modern versions of 
Windows you will find that, apart from the fact that Windows still has a command prompt available, the 
two operating systems have very little in common. 

 
Text vs. Graphics 
The primary way that an MS-DOS computer displays information is through plain text. Although many 
MS-DOS applications do have graphics, basic operating system tasks such as browsing and copying files 
take place entirely in text unless a graphical shell (a program that runs on top of the MS-DOS operating 
system) is used. In Windows, all operating system tasks take place within a graphical environment. 
Small pictures called "icons" represent each file and program. Early Windows versions are, in fact, 
graphical shells for MS-DOS. It was not until the release of Windows XP in 2001 that most home 
computer owners moved completely away from MS-DOS-based operating systems. 

 
Input System 
MS-DOS uses text for all basic operating system commands. For example, the command "dir" lists the 
files in a directory, while the command "cd" navigates to a different directory. Windows uses a mouse 
for all operating system input except tasks that explicitly require text, such as creating a document or 
responding to email. 

 
Multitasking 
Windows is a multitasking operating system, meaning that it can run multiple program processes 
simultaneously. A typical Windows session might consist of the user browsing the Web while adding 
music to an MP3 player with their email program checking for new messages in the background. MS- 
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DOS is unable to run multiple tasks simultaneously. When you want to do something else on an MS-DOS 
computer, you need to quit the current program and run a different one. 
Storage Size 
Hard drives manufactured today contain hundreds—and even thousands—of gigabytes of storage 
space. However, the final standalone version of MS-DOS, DOS 6.22, used the now-obsolete FAT16 file 
system. The maximum partition size that FAT16 supports is just 2 GB. Today, 2 GB is a very small 
amount of storage, with memory cards the size of fingernails easily storing that amount. 

 
Introduction to DOS / WINDOWS 
Though UNIX was a powerful operating system available, but it was not suitable for 8-bit 8086 
microprocessor based Personal Computers. So there was a need for a small operating system that could 
work in 640K memory(RAM). DOS was an variant of CP/M (Control Program/Monitor) which ran for 
the first time on IBM-PC in 1981. It is called so because it resides on Floppy or Hard disk and provides 
command level interface between user and the computer hardware. The different versions of MS-DOS 
have evolved over a period of time with Microsoft introducing new features in each new releases. 
Starting with MS-DOS1.1, the latest version was MS-DOS6.22 released in 1994. There are various 
versions of DOS like MS-DOS(Microsoft), PC-DOS(IBM), Apple DOS, Dr-DOS etc. 
WINDOWS was similar to APPLE Mach operating system interface on IBM-PC. The main features of 
windows are easy to use graphical user interface (GUI), device independent graphics and multitasking 
support. The first version of windows1.0 was introduced in 1985. Windows was an application of MS- 
DOS using the basic commands of DOS. Windows for Workgroup (WIN3.11) released in 1992 was an 
integrated windows and networking package with file and printer sharing capabilities, a network mail 
(Microsoft Mail) and a workgroup scheduler (Schedule+) packages in windows environment. 
WINDOWS-95 released in 1995 is a 32-bit operating system which includes MS-DOS7.0 and takes 
control of computer system after starting. 

 
DOS: 
MS-DOS was the original operating system for (IBM) PC's, and served as the base on top of which 
Windows was originally written. MS-DOS provided a text-based 'command-line interface' instead of the 
visual interface of the Mac and Windows. 
Some knowledge of this command-line interface is still valuable for running older (MS-DOS) programs, 
and for writing 'scripts' ... sequences of operating system commands (also called batch or .BAT files). 

 
The structure of Disk Operating System for IBM PC-compatible computers can be broken down into 
four distinct components: 

 BIOS Module

 Kernel
 Command Processor
 External Commands

 
The operating system responsible for operating the disk is known as disk operating system or DOS. DOS 
helps in execution of all programs present in computer system. It can be operated upon by a single user 
operating system. DOS works to control all activities of the computer like deciding locations for the 
programs to be loaded, transferring files from hard disk to memory, accepting data from the keyboard, 
displaying information on the screen, handling printing tasks and so on. 

 
File names and directory structure 
A DOS file can have an 8 character name + an optional 3 character extension. The extension is intended 
to indicate the 'type' of the file. Most DOS and Windows programs assume some particular extension  
for the file they use; Windows uses the extension to associate a particular program with a file. 

 
The files are organized in a tree-structured directory. An arbitrary file is specified by a path, 
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device:\directory\directory\...\filename.ext 
 

The special file name '.' refers to the current directory; the file name '..' refers to the parent directory. 
Long Windows file names, and file names containing blanks or certain special characters, are mapped 
into MS-DOS file names of the form cccccc~1, cccccc~2, etc. They can also be referenced using the full 
file name inside of double-quote marks ("). 

 
History and versions of DOS :- 
1981 Microsoft buys the rights for QDOS from Seattle Computer Products (SCP) for $25,000 on 27’July. 
1981 MS-DOS 1.0 was released August, 1981. 
1982 MS-DOS 1.25 was released August, 1982. 
1983 MS-DOS 2.0 was released March, 1983. 
1984 Microsoft introduces MS-DOS 3.0 for the IBM PC AT and MS-DOS 3.1 for networks. 
1986 MS-DOS 3.2 was released April, 1986. 
1987 MS-DOS 3.3 was released April, 1987. 
1988 MS-DOS 4.0 was released July, 1988. 
1988 MS-DOS 4.01 was released November, 1988. 
1991 MS-DOS 5.0 was released June, 1991. 
1993 MS-DOS 6.0 was released August, 1993. 
1993 MS-DOS 6.2 was released November, 1993 
1994 MS-DOS 6.21 was released March, 1994 
1994 MS-DOS 6.22 was released April, 1994 

 
Types of DOS: 
There are two types of DOS:- 

 MS-DOS
 PC-DOS

 
Functions of DOS:- 

 It interact with the software or various application programs
 It provides file management utilities that perform useful tasks:-
1. Disk preparation 
2. File operations 
 It helps to automate the repetitive tasks.
 It co-ordinates with the functions of computer system

 It controls the execution of the program instruction

 It controls the way certain information is displayed on the screen

 It control the way your computer interprets certain command

 
BOOTING process:- 
When the computer is switched on, the firmware program in Read Only Memory(ROM) also called  
Basic Input-Output System(BIOS) reads programs and data i.e. Operating System and loads it into 
memory (RAM). This process is known Bootstrapping(Booting). The OS once loaded takes control of  
the computer, handles user interaction and executes application programs. 
During Booting process, computer loads the operating system into its memory. DOS booting involves 
reading following files into memory namely IO.SYS, MSDOS.SYS, and COMMAND COM. The Basic 
Input/Output Program (IO.SYS): This program provides interface between the hardware devices and 
software of the system. It takes care of the keyboard input, character output to monitor, output to 
printer and time of the day. 
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The File and Disk Manager Program (MSDOS.SYS) : It contains the file management and the disk 
buffering management capabilities. It keeps track of all the disk access of an application program and 
remains permanently in memory. 

 
The Command Processor (COMMAND.COM) : It is also called command interpreter. It is the program 
that displays the system prompt and handles user interface by executing the command typed in by the 
user using keyboard. 

 
DOS commands:- 
Any instruction given to the computer to perform a specific task is called command. The DOS has 
several commands, each for a particular task and these are stored in DOS directory on the disk. The 
commands are of two types : (a)Internal Commands : These are in built commands of MS-DOS i.e. these 
are stored in Command interpreter file (COMMAND.COM). These commands reside in the memory as 
long as the machine is at he system prompt(C:\>) level. To use these commands no extra /external file 
is required. E.g. DATE, TIME, DIR, VER etc. (b) External commands : These are separate program (.com) 
files that reside in DOS directory and when executed behave like commands. An external command has 
predefined syntax. for e.g. HELP, DOSKEY, BACKUP, RESTORE, FORMAT etc. 

 
Internal Commands:- 

 DIR command:- Display the list of files and directories.
 MD or MKDIR command:- To make or create a new directory in the disk.
 CD or CHDIR command:- To switch from one directory to another.
 RD or RMDIR command:- To go inside the particular directory

 COPY command:- To copy one or specified files from one disk to another
 DEL command:- To delete any file present on the disk

 REN command:- To change the name of one or more files
 VOL command:- Display Disk Volume Label and volume serial number.
 DATE command:- It will display the system’s current date
 TIME command:-It will show current time of the system

 CLS command:- To clear screen

 PATH command:- Displays or sets a search path for executable files
 TYPE command: - Displays the contents of standard text files on the screen

 
External Commands:- 

 CHKDSK commands:- To check the status of a selected disk.
 XCOPY command:- Used to copy files and directory except system and hidden files.
 PRINT command:- To print one or more files.
 DISKCOPY command:- To make an exact duplicate of the original disk.
 DISKCOMP command:- To compare the content of two floppy disks to ensure they are identical.
 DOSKEY command:- Stores all DOS commands typed from the DOS prompt into the memory.
 TREE command:- Displays all the directory pathnames on the specified disk.
 MOVE command:- To move a directory ane one or more files from one location to another on 

the same disk.
 LABEL command:- To create, change or delete a volume label so as to identify a disk.
 APPEND command:- Allows to find files even when they are not in its own directory.
 FORMAT command:- To create a new root directory and file allocation table for the disk.

 

MS Windows 
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Windows   XP is   a personal   computer operating   system produced   by Microsoft as    part    of 

the Windows NT family of operating systems. The operating system was released to manufacturing 

on August 24, 2001, and generally released for retail sale on October 25, 2001. 

 

Windows XP is a graphical user interface (GUI). It has pictures (graphical) that you use (user) to 

communicate (interface) with the computer. This type of system is popular because it's logical, fun, 

and easy to use. 

This operating system has multi-tasking capabilities, meaning it can run several applications at the 

same time. Multi-tasking allows you to view this lesson on the Internet at the same time you practice 

using other applications with Windows XP. 

History of Windows: 

 

Versions Year 

Windows 10 Nov.1983 

Windows 1.0 Nov.1985 

Windows 2.0 09 Dec.1987 

Windows 3.0 22 May.1990 

Windows 95 August 1995 

Windows 98 June 1998 

Windows 2000 Feb.2000 

Windows XP 25 Oct. 2001 

Windows Vista 2007 

Windows 7 22 July 2009 

Windows 8 26 Oct. 2012 

 

The New and updated features in the new program are: 

 Windows XP is faster, smarter, safer

 Windows XP is easier to learn and use

 Windows XP offers better help for 
every task

 Playing music, video and CDs

 Offers wizard

 User interface

 Infrastructure

 Networking and internet functionality

 

Windows XP editions 

 Home and Professional

 Starter Edition

 Media Center Edition

 Tablet PC Edition

 Subscription and pre-paid editions

 64-bit editions

 Editions for embedded systems
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Windows XP is an operating system 

Windows XP is a collection of programs, which enables the entire pc to work. Among Windows’ 

most important tasks are: 

 Assist in starting the pc.

 Control and handling of all hardware, including RAM, I/O, cards and controllers.

 Read-in of a graphics user interface with windows, menu bars etc.

 Forms a platform for the user programs (applications) like Word, Internet Explorer, and 

Photoshop etc.

 Handling of user data in files.

 

Beyond the pure operating system tasks Windows XP includes a large collection of smaller and 

larger tools. Among others Windows XP comes with Internet Explorer and the multimedia player 

Windows Media Player, which are independent user programs. 

 

 

 

 

 

 

 

 

 

 

 
Windows XP is both an operating system and a program package. 

 

Desktop 

Desktops in a Windows is utility that allows users to manage applications on up to four virtual 

desktops, all accessible using the tray icon interface. 4. When referring to an operating system or 

GUI, the Desktop is a system of organization of icons on a screen. The Microsoft Windows Desktop 

was first introduced with Microsoft Windows 95 and has been included with every version of 

Windows since then. 
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The desktop contains: 

 Start button: This is one of the most important tools you will use while working with 

Windows XP. The Start button allows you to open menus and start applications.

 Taskbar: This is primarily used to switch between open windows and applications. Learn 

more about using the taskbar in a later lesson.

 Icons (or graphical pictures): This represents applications, files, and other parts of the 

operating system. By default, Windows XP provides you with one desktop icon, the Recycle 

Bin.

 Windows Notification Area

 Time and Date: The date and time is also shown on the Desktop, in the notification area on 

the taskbar. If the date and time is incorrect, you can change the date and time right from the 

Desktop.

 

Exploring Windows Explorer 

Windows Explorer is a file management tool that lets you create, rename, and delete folders. It also 

allows you to copy, print, move, delete, rename, and manage files. 

To open Windows Explorer: 

1. Open My Documents. 

2. Click the Folders button on the Navigation toolbar. 

3. A list of folders opens in the left pane. 

To explore Windows Explorer: 
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1. With Windows Explorer open, scroll until you see the Control Panel icon in the left pane. 
2. Click the Control Panel icon. The contents (of the Control Panel folder) display in the right 

pane. 

3. Practice viewing other folders in the list. 

4. To close Windows Explorer, click the small black X in the upper right of the list OR click 

the Folder button. 

 

The Taskbar 

The taskbar is the small blue bar you see at the bottom of your desktop.  It  contains the Start  

menu and the Quick Launch bar, which contains icons for Internet Explorer, Windows Media 

Player, and Show Desktop. Click an icon to open a program. Click Show Desktop to quickly view 

your desktop without closing any programs or windows. 

 

 

 
 

The box on the right is called the Notification Area. Microsoft also uses the Notification Area to 

remind you when software updates are available for download. 

 

 
When you open or minimize a window or program, a rectangular button appears on the taskbar 

that shows the name of the application. 

 

The Start menu 

When you click the Start button, the Start menu appears. The Start menu is your path to the 

applications on your computer. It contains two columns. The left side of the Start menu lists 

programs, while the right side allows access to common Windows folders (My Documents, for 

example). It also provides access to Help and Support, Search, and Run. If you select All 

Programs, a pop-up menu appears. Pop-up menus like this are called cascading menus. If a 

cascading menu is available, a small black triangle appears next to the name of the application or 

function. 

To explore the Start menu: 

1. Click the Start button. 
2. Move the mouse pointer to each option, and view the various cascading menus. 

3. Click (or roll your mouse pointer over) All Programs. 

4. Move the mouse pointer to the right, and view other cascading menus. 

5. To exit the menus, click outside the menu area or press Esc on your keyboard. 
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The Recycle Bin 

The Recycle Bin is nothing more than a space on the hard disk reserved to store information that is 

deleted so that in the event of deleting a file or folder by mistake it is possible to retrieve it. By 

default the Recycle Bin restores files or folders to the place from where they were deleted. If, for 

example, a file is deleted from D:\my documents, when it is restored it will go to that folder. 

The Recycle Bin will maintain the deleted documents until it is emptied. 

To  open  the  Recycle  Bin  place   the   cursor   on Desktop and   double-click   on   the Recycle  

Bin icon. 

Restoring Files or Folders 

To restore all of the elements from the Recycle Bin click on the green arrow on the left side that  

says restore all items. 

 

If we only want to restore some of the elements: 

1) Select the elements to be restored by clicking on them. If the elements are not in subsequent order, 

use the Ctrl key to select them or the Shift key if they are one below the other. 

2) Once selected, a dialog box will appear on the green arrow on the left that will say Restore this 

item or Restore the selected items. 

The selected files will return to where they were located before deletion. 

 

Deleting Files or Folders from the Recycle Bin 

Before deleting any element from the Recycle Bin you need to realize that once it is deleted it cannot 

be retrieved or restored. 
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If you want to delete any file or folder from the Recycle Bin follow these steps: 

1) Select the Elements to be deleted. 

2) Click  on ; this will delete  the  selected  elements. You  can  also  do  this  by  pressing  

the Delete button. 

The selected files will disappear and cannot be restored. 

 

My Computer 

It is another tool you can use to manage files and folders. With this tool, you can create, rename 

and move folders and copy, print, move, delete and rename files. It also allows you to gain access 

to other 

system tools. 

To open My Computer: 

1. Double-click the My Computer icon on the desktop. 

2. My Computer opens. 

 

My Network Places overview 

My Network Places displays shortcuts to shared computers, printers, and other resources on the 

network. The shortcuts are created automatically in My Network Places whenever you open a shared 

network resource, such as a printer or shared folder. 

 

Open My Network Places 

 To open My Network Places, click Start, and then click My Computer. Under Other Places, 

click My Network Places. 

 The View workgroup computers task is displayed in My Network Places when your 

computer is in a workgroup and not in a domain. Double-click this icon to narrow your 

search to only those computers, printers, and resources that share a workgroup with your 

computer. 

 If your computer is connected to a workgroup that has less than 32 computers, Windows will 
automatically create shortcuts in My Network Places to the shared resources in your 
workgroup. 

 To add a shortcut in My Network Places to a folder on a Web server, the Web server must 
support network places.. 

 

My Documents 

The My Documents folder is your own personal folder in which you can store your documents, 

graphics, and other personal files. You can change the target if you want My Documents to point to a 

different folder location. 

 Change the Default Location of the My Documents Folder 

 To change the default location of the My Documents folder, follow these steps: 

 Click Start, and then point to My Documents. 

 Right-click My Documents and then click Properties. Click the Target tab. 

 

User Accounts 

To get at the settings for the User Accounts, click Start and then Control Panel. From the Control 

Panel, double click User Accounts. 

 We can create a new user account. 

 We can make the account as password protected. 
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 Through admin we can even change the password. 

 

Windows XP Accessories Applications: 

 Calculator, 

 Notepad, 

 WordPad, 

 Paint 

 

 

UNIT-III 
A word processor is an electronic device or computer application software that performs word 
processing: the composition, editing, formatting and sometimes printing of any sort of written material. 
Word processing can also refer to advanced shorthand techniques, sometimes used in specialized 
contexts with a specially modified typewriter. 
The word processor emerged as a stand-alone office machine in the 1970s and 1980s, combining the 
keyboard text-entry and printing functions of an electric typewriter with a dedicated computer 
processor for the editing of text. 

 
Characteristics 
Word processing typically implies the presence of text manipulation functions that extend beyond a 
basic ability to enter and change text, such as automatic generation of: 

 batch mailings using form letter template and an address database (also called mail merging); 
 indices of keywords and their page numbers; 
 tables of contents with section titles and their page numbers; 
 tables of figures with caption titles and their page numbers; 
 cross-referencing with section or page numbers; 
 footnote numbering; 
 new versions of a document using variables (e.g. model numbers, product names, etc.) 

 
Examples of different word processing software are: 

 WordPerfect 
 Microsoft Word 
 WordMark 
 Lotus WordPro 
 Procedure Write 

 
Types of word processor:- 

 Dedicated word processor 
 Standard word processor software packages 
 Word processing packages on minicomputer 

 
Features of Word : 

1) Word wrap 
2) Editing of text 
3) Page formatting 
4) Paragraph formatting 
5) Text formatting 
6) Retriving of your work 
7) Mail Merge 

8) Spelling & grammer check 
9) Use of thesaurus 
10) Online Assistant 
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Each of the tabs contains the following tools: 
Home: Clipboard, Fonts, Paragraph, Styles, and Editing. 
Insert: Pages, Tables, Illustrations, Links, Header & Footer, Text, and Symbols 
Page Layout: Themes, Page Setup, Page Background, Paragraph, Arrange 
References: Table of Contents, Footnote, Citation & Bibliography, Captions, Index, and Table of 
Authorities 
Mailings: Create, Start Mail Merge, Write & Insert Fields, Preview Results, Finish 
Review: Proofing, Comments, Tracking, Changes, Compare, Protect 
View: Document Views, Show/Hide, Zoom, Window, Macros 

 
Create a New Document 
There are several ways to create new documents, open existing documents, and save documents 
in Word: 

 Click the Microsoft Office Button and Click New or 
 Press CTRL+N on the keyboard 

 
Opening an Existing Document 

 Click the Microsoft Office Button and Click Open, or 
 Press CTRL+O on the keyboard, or 
 If you have recently used the document you can click the Microsoft Office Button and 

click the name of the document in the Recent Documents section of the window Insert 
picture of recent docs 

 
Saving a Document 

 Click the Microsoft Office Button and Click Save or Save As, or 
 Press CTRL+S on the keyboard, or 
 Click the File icon on the Quick Access Toolbar 

 
Renaming Documents 
To rename a Word document while using the program: 

 Click the Office Button and find the file you want to rename. 
 Right-click the document name with the mouse and select Rename from the shortcut 

menu. 
 Type the new name for the file and press the ENTER key. 

 
Working on Multiple Documents 
Several documents can be opened simultaneously if you are typing or editing multiple 
documents at once. All open documents will be listed in the View Tab of the Ribbon when you 
click on Switch Windows. The current document has a checkmark beside the file name. Select 
another open document to view it. 

 
Document Views 
There are many ways to view a document in Word. 

 Print Layout: This is a view of the document as it would appear when printed. It 
includes all tables, text, graphics, and images. 

 Full Screen Reading: This is a full view length view of a document. Good for viewing 
two pages at a time. 

 Web Layout: This is a view of the document as it would appear in a web browser. 
 Outline: This is an outline form of the document in the form of bullets. 
 Draft: This view does not display pictures or layouts, just text. 

To view a document in different forms, click the document views shortcuts at the bottom of the 

screen  or: 
 Click the View Tab on the Ribbon 
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 Click on the appropriate document view. 
 

Close a Document 
Click the Office Button 

 Click Close 
 

There are many features to help you proofread your document. These include: Spelling and 
Grammar, Thesaurus, AutoCorrect, Default Dictionary, and Word Count. 

 
Editing text selecting – to select text with the mouse use the following steps – 

1) Take the mouse pointer before the place you want to select text from and drag it to 
the place till you want. 

2) Select the text with keyboard 
 

Inserting & Deleting Text – You can insert or delete text in several ways. 
1) Select a block of text from beginning to the last character. To delete press Del key from the 

keyboard this process will delete the entire block. 
2) To delete single character use Del key or backspace key. 
3) To Insert the text select the text copy the text and paste the text where ever you want. 
4) There are different pasting options you can use. 

Formatting Features of Ms word:- 

 
 
 
 
 
 
 

Function of commonly used buttons 

 
Select the style to apply to paragraphs Changes the font of the selected text 

 

Changes the size of selected text and 
numbers 

Makes selected text and numbers 
bold 

 

Makes selected text and numbers  
italic 

Aligns to the left with a ragged right 

Underlines selected text and 
numbers 

margin Centers the selected text 
 

Aligns to the right with a ragged left 
margin 

 
Makes a numbered list or reverts back 
to normal 

 
Decreases the indent to the previous 
tab stop 

Aligns the selected text to both the 
left and right margins 

 
Add, or remove, bullets in a selected 
paragraph 

Indents the selected paragraph to the 
next tab stop 

 

Adds   or   removes   a  border  around Marks text so that it is highlighted 
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selected text or objects and stands out 

 
       Formats the selected text with the 

color you 

Text Selecting – 
You can select the text in two ways – 

 By using shift key 
 By using mouse 

Once the text is selected you can change the formatting of the selected text. You can delete, 
move the text from one position to other. 
Previewing the document – 
Before printing the documents you can preview the document. In preview option we can change 
the margin, page layout, size etc features of your document. The step to preview the document 
is as follows – 

1) Click MS-Office button 
2) Click on print button & then 
3) Click on print preview 

 
 
 
 
 
 
 
 
 

Printing Document to a file page – 
You can print the document. There are two different features to print the document are as 
follow – 

3) Print – In print option you can change the number of copies, Select page no., 
choose printer etc before printing. 

4) Quick Print – In quick print the document is directly send to the printer without 
making any changes. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Reduce the no. of pages by one – 
You can shrink the document pages to by one page. Attempt to shrink the document by one page 
by slightly reducing the size and spacing of the text. The option to reduce number of pages by 
one can be selected from Print Preview option. 
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Paragraph Formatting 

 
 
 
 
 
 

Paragraph formatting provide us the facility to format the paragraph written in the document. 
The paragraph formatting include the formatting features – 

 Alignment – There are different alignments like left, center, rights & Justified. 
 Line Spacing - In Line Spacing option you can change the spacing between the lines. 
 Shading – In this option you can Color the background of the selected text or paragraph. 
 Border – You can customize the border of the selected text or cell. 

 
 
 
 
 
 
 

 
 Sorting options - In sorting option we can sort the text in alphabetical order or 

numerical order. 
 Numbering / Bullets – We can create bullet list or numbering list through this option. 
 Indent – Indentation determine the distance of paragraph from either the left or right 

margin. 
Headers and Footers 
Header & footer may be text or graphics printed on top & bottom of the document. Header is 
printed on top margin area & footer is printed on bottom margin area. Headers and footers are 
pieces of text or graphics that appear at the top and bottom of a page. After you set up a header 
and footer, they will appear on all of your pages. You can add a page number to a header or 
footer, and Microsoft Word will automatically insert the right page number for you. 
To set up a header and footer for your document, click on the Insert tab at the top of Word. Now 
locate the Header & Footer panel: 

 
 
 
 
 

Footers 
Microsoft Word allows you to insert page numbers into your document. This is done (usually) in 
the Footer area of the page. The Footer is just the opposite of the Header. You can do the same 
things with the Footer as you can with the Header. We'll see how to insert page numbers into 
the Footer. Make sure the Design tab is select at the top of Word. Now locate the Navigation 
panel again. Click the item that says "Go to Footer": 
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Multiple Columns – 
With the use of multiple column option you can Spilt text into two or more columns. You can 
select this option from Page layout tab. 

UNIT IV 
Microsoft’s EXCEL has become the standard for basic data analysis. And, again, individuals  
with a college education in the 21st century will be expected to have a working knowledge of  
this foundational package. EXCEL is critical to understand not only because it facilitates basic 
data analysis, but also because it is typically the starting point for PC-based data which can then 
be analyzed using more sophisticated packages like SPSS, Minitab or SAS. 

 
When you open EXCEL, the interface includes row and columns, with “cells” at the intersections. 
You can input data or formulas into the individual cells. 

 
Spreadsheets are made up of columns, rows and their intersections are called cells. 
Column- In a spreadsheet the COLUMN is defined as the vertical space that is going up and 
down the window. Letters are used to designate each COLUMN'S location 
Row - In a spreadsheet the ROW is defined as the horizontal space that is going across the 
window. Numbers are used to designate each ROW'S location. 
Cell - In a spreadsheet the CELL is defined as the space where a specified row and column 
intersect. Each CELL is assigned a name according to its COLUMN letter and ROW number(A1). 
In a spreadsheet there are three basic types of data that can be entered. 

 labels - (text with no numerical value) 
 constants - (just a number -- constant value) 
 formulas* - (a mathematical equation used to calculate) 

 
To Create an Excel Workbook: 
Choose File New from the menu bar 
Choose Blank Workbook under the New category heading. 
A blank workbook opens in the Excel window. The New Workbook task pane is closed. 

 
To Save a new Workbook: 
Choose File Save As from the menu bar. The Save As Dialog Box appears. 
Click on the Save In: dropdown menu and locate where the file will be saved. Type a name for 
your file in the File Name: box. Click the Save button 

 
To Save Changes Made to an Existing Workbook: 

Choose File Save from the menu bar, or Click the Save button on the Standard toolbar. 

 If you're saving the file for the first time and you do not choose a file name, Microsoft Excel 
will assign a file name for you. 

 It is a good idea to Save frequently when working in a spreadsheet. You can quickly save 
your spreadsheet by using the quick-key combination Ctrl + S. 

 
To Open an Existing Excel 2003 Workbook: 
Choose File Open from the menu bar. 

 
To close an existing Excel 2003 Workbook: 
Choose File Close from the menu bar. The workbook in the Excel window is closed. 
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To Enter Data into a Cell: 
Click the cell where you want to type information. Type the data. An insertion point appears in 
the cell as the data is typed. The data can be typed in either the cell or the Formula bar. Click the 
cell that contains the information to be changed. Type the new entry. The old entry is replaced 
by the new entry. 

 
To Edit Information in a Cell: 
Method 1: Direct Cell Editing - Double-click on the cell that contains the information to be 
changed. 
Method 2: Formula Bar Editing - Edit the entry in the formula bar 
Click the cell that contains the information to be deleted.  Press the Delete key, or Right-click  
and choose Clear Contents from the shortcut menu. 

To  Undo  Recent  Actions  (typing,  formatting,  etc),  One  at  a  Time:   Click  the Undo 
button. 
To Undo Several Recent Actions at Once: Click the arrow next to the Undo button. Select the 
desired Undo operation(s) from the list 

To Redo an Undo Operation: Press the Redo button. 
To Redo several recent Undo actions at once: Click the arrow next to Redo button. Select the 
desired Redo operation from the list. Microsoft Excel reverses the Undo operation. 
Selecting Multiple Cells 
The currently-selected cell in Excel is called the active cell. You can also select a group of 
adjacent cells, or a cell range. Many operations can be done against a cell range: move it, copy, it, 
delete it or format it. 
To Select All Cells in a Column or Row: 
Click the gray Column heading to select the entire column. (Click and drag the cursor across 
other column headings to select those columns 
Click the gray Row heading to select the entire row. (Click and drag the cursor down through the 
row headings select those rows 

 
To Select the Entire Worksheet: Click the gray rectangle in the upper left corner to select 
entire worksheet. 
Cut , Copy & Paste 
The Cut, Copy and Paste buttons are located on the Standard toolbar. The Cut, Copy and Paste 
operations also appear as choices in the Edit menu. The Cut, Copy and Paste operations can also 
be performed through shortcut keys: ctrl+c, ctrl+v, ctrl+x. 
Copy - The Copy feature allows you to copy selected information from the spreadsheet and 
temporarily place it on the Clipboard, which is a temporary storage file in your computer's 
memory. The Paste feature allows you to select any of the collected items on the Clipboard and 
paste it in a cell of the same or different spreadsheet. 
Cut and Paste Cell Contents - The Cut feature allows you to remove information from cells in 
the spreadsheet. Information that is cut can be pasted in another cell, as long as the pasting 
occurs before you perform another operation. If you don't paste the cut information 
immediately, it is removed from the Office clipboard. 
Moving Information Using Drag-and-Drop 
Another way to move information from one cell to another is to use the drag-and-drop method. 
You use the cursor to point to the information to be moved and then drag the cell to its new 
location. 
Formula - A formula can be a combination of values (numbers or cell references) and math 
operators (+, -, /, *, =) into an algebraic expression. 

 
To Create a Simple Formula that Adds the Contents of Two Cells: 

 Type the numbers you want to calculate in separate cells (for example, type 128 in cell 
B2 and 345 in cell B3). 
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 Click the cell where the answer will appear (B4, for example). 
 Type the equal sign (=) to let Excel know a formula is being defined. 
 Type the cell number that contains the first number to be added (B2, for example). 
 Type the addition sign (+) to let Excel know that an add operation is to be performed. 
 Type the cell number that contains the first number to be added (B3, for example). 
 Press Enter or click the Enter button on the Formula bar to complete the formula 

 
To Create a Simple Formula using the Point and Click Method: 

 Click the cell where the answer will appear (B4, for example). 
 Type the equal sign (=) to let Excel know a formula is being defined. 
 Click on the first cell to be included in the formula (B3, for example). 
 Type the subtraction sign (-) to let Excel know that a subtraction operation is to be 

performed. 
 Click on the next cell in the formula (B2, for example). 

 
Complex Formulas Defined 
Simple formulas have one mathematical operation. Complex formulas involve more than one 
mathematical operation. The order of mathematical operations is very important. If you enter a 
formula that contains several operations--like adding, subtracting and dividing, The order of 
operations is: 

 Operations enclosed in parenthesis 
 Exponential calculations (to the power of) 
 Multiplication and division, whichever comes first 
 Addition and subtraction, whichever comes first 

 
Filling Formulas to Other Cells 
The fill formula method allows you to copy a formula and fill it into many different consecutive 
cells at the same time.The mouse pointer changes to a black crosshair when passed over the fill 
handle, or the square box in the lower right corner of the cell. 

 
To Use the Fill Handle to Copy a Formula to a Surrounding Cell: 

 Click on the cell that contains the formula to be copied. 
 Position the mouse pointer over the fill handle. 

 Click and hold the left mouse button, and then drag the contents to the cell that's to 
receive the fill formula. 

 Release the mouse button. 
 Select the Copy Cells option in the fill formula drop-down menu. 

 
Using Functions 
A function is a pre-defined formula that helps perform common mathematical functions. 
Functions save you the time of writing lengthy formulas. You could use an Excel function called 
Average, for example, to quickly find the average of range of numbers. Or you could use the Sum 
function to find the sum of a cell range. Excel contains many different functions. Each function 
has a specific order, called syntax, which must be strictly followed for the function to work 
correctly. 

 
Syntax Order: 

 All functions begin with the = sign.
 After the = sign define the function name (e.g., Sum).
 If there is more than one argument, separate each by a comma.

An example of a function with one argument that adds a range of cells, B3 through B10: 
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An example of a function with more than one argument that calculates the average of numbers 
in a range of cells, B3 through B10, and C3 through C10: 

 
 

 
Excel literally has hundreds of different functions to assist with your calculations. There are 
many different functions in Excel 2003. Some of the more common functions include: 

 
Statistical Functions: 

 SUM - summation adds a range of cells together.
 AVERAGE - average calculates the average of a range of cells.
 COUNT - counts the number of chosen data in a range of cells.
 MAX - identifies the largest number in a range of cells.
 MIN - identifies the smallest number in a range of cells.

 
Financial Functions: 

 Interest Rates
 Loan Payments
 Depreciation Amounts

 
Date and Time functions: 

 DATE - Converts a serial number to a day of the month

 Day of Week

 DAYS360 - Calculates the number of days between two dates based on a 360-day year
 TIME - Returns the serial number of a particular time
 HOUR - Converts a serial number to an hour
 MINUTE - Converts a serial number to a minute
 TODAY - Returns the serial number of today's date
 MONTH - Converts a serial number to a month

 YEAR - Converts a serial number to a year
 

To Name a Worksheet:- Double-click the sheet tab to select it. The text is highlighted by a black 
box. 

 
 
 
 

Type a new name for the worksheet. 

 
 
 

 
Press the Enter key. 
The worksheet now assumes the descriptive name defined. 

 
Inserting Worksheets 
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By default, each new workbook in Excel defaults to three worksheets named Sheet1, Sheet2 and 
Sheet3. You have the ability to insert new worksheets if needed or delete others you no longer 
want. 
To Insert a New Worksheet: 
Choose Insert Worksheet from the menu bar. 

 
 
 
 
 
 
 
 
 
 
 

 
A new worksheet tab is added to the bottom of the screen. It will be named Sheet4, Sheet5 or 
whatever the next sequential sheet number may be in the workbook. 

 
Deleting Worksheets - Any worksheet can be deleted from a workbook, including those that 
have data in it. Remember, a workbook must contain at least one worksheet. 

Click on the sheet(s) you want to delete. Choose Edit Delete Sheet from the menu bar. 

 
 
 
 
 
 
 
 
 
 
 

The following dialog box appears if the sheet being deleted contains information  on  it.  
Click the Delete button to remove the worksheet and all the data in it. 

 
Moving Worksheets 
When you move a sheet, you are moving it to a new location in this or another workbook. 
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Select the worksheet you want to move/copy. Choose Edit Move or Copy from the menu bar. 

 
 
 
 
 
 
 
 
 
 
 

 
In the Move or Copy dialog box, use the drop down boxes to select the name of the workbook 
you will move the sheet to (the current workbook is the default). Also define where you want 
the sheet positioned in the workbook. 

 
 
 
 
 
 

 
Click the OK button to move the worksheet to its new location. 

 
Copying Worksheets 

 Select the worksheet you want to move/copy.
 Choose Edit Move or Copy from the menu bar.
 In the Move or Copy dialog box, use the drop down boxes to select the name of the 

workbook you will copy the sheet to (the current workbook is the default). Also define 
where you want the sheet positioned in the workbook.

 Click the Create a copy checkbox.

 
 
 
 
 
 
 
 

 Click OK to create an exact copy of the worksheet and move it to the location specified.
 

Inserting a row 
 Click anywhere in the row below where you want to insert the new row.
 Choose Insert Rows from the menu bar.

OR 
 Click anywhere in the row below where you want to insert the new row.
 Right-click and choose Insert from the shortcut menu.
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To Insert a Column: 
Click anywhere in the column where you want to  insert  a  new  column.  Choose  Insert 
Columns from the menu bar. 

 
 
 
 
 
 
 
 
 
 
 
 

A new column is inserted to the left of the existing column. 
OR 

 Click anywhere in the column where you want to insert a new column.
 Right-click and choose Insert from the shortcut menu.

 
Deleting columns and rows 

 Select a cell in the row to be deleted.
 Choose Edit Delete from the menu bar.
 Click the Entire Row radio button in the Delete dialog box.

 
 
 
 
 
 
 

 

 Click the OK button.

 
To Delete a Column and All Information in it: 

 Select a cell in the column to be deleted.
 Choose Edit Delete from the menu bar.

 Click the Entire Column radio button in the Delete dialog box. Click the OK button.
 

Adjusting column widths 
By default, Excel's columns are 8.43 characters wide, but each individual column can be 
enlarged to 240 characters wide. 
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You can adjust column width manually or use AutoFit. 
 

To Manually Adjust a Column Width: 
 Place your mouse pointer to the right side of the gray column header.
 The mouse pointer changes to the adjustment tool (double-headed arrow).

 
Adjusting row height 

 Place your mouse pointer to the lower edge of the row heading you want to adjust.
 The mouse pointer changes to the adjustment tool (double-headed arrow).

 
 
 
 
 
 
 
 

Drag the Adjustment tool up or down to the desired height and release the mouse button. 

 
 
 
 
 
 
 
 
 
 

To AutoFit the Row Height: 
 Place your mouse pointer to the lower edge of the row heading you want to adjust.
 The mouse pointer changes to the adjustment tool (double-headed arrow).
 Double-click to adjust the row height to "AutoFit" the font size.

 
Understanding the Different Chart Types 
Area Chart - An area chart emphasizes the trend of each value over time. An area chart also 
shows the relationship of parts to a whole. 
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Column Chart - A column chart uses vertical bars or columns to display values over different 
categories. They are excellent at showing variations in value over time. 

 
 
 
 
 
 

 
Bar Chart - A bar chart is similar to a column chart except these use horizontal instead of 
vertical bars. Like the column chart, the bar chart shows variations in value over time. 

 
 
 
 
 
 

Line Chart - A line chart shows trends and variations in data over time. A line chart displays a 
series of points that are connected over time. 

 
 
 
 
 
 
 

Pie Chart - A pie chart displays the contribution of each value to the total. Pie charts are a very 
effective way to display information when you want to represent different parts of the whole, or 
the percentages of a total. 

 
 
 
 
 

 
Other charts that can be created in Excel include: Doughnut; Stock XY (scatter); Bubble; Radar; 
Surface; or Cone, Cylinder, and Pyramid charts.. 
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The AutoFilter feature makes filtering, or temporarily hiding, data in a spreadsheet very easy. 
This allows you to focus on specific spreadsheet entries. 
To Use AutoFilter: 
Select Data from the main menu. 
Select Filter AutoFilter. 
Click the drop-down arrow next to the heading you would like to filter. 
For example, if you would like to only view data from the West Sales Region, click the drop- 
down arrow next to Sales Region. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Choose the data you would like to display. 
In this example, you would choose West. All other data will be filtered, or hidden, and only the 
West Sales Region data is visible. 

Click the drop-down arrow again and select All to display all of your original data. 
Sorting lists is a common spreadsheet task that allows you to easily reorder your data. The most 
common type of sorting is alphabetical ordering, which you can do in ascending or descending 
order. 
In this example, we will alphabetize the employee names. 
To Sort in Ascending or Descending Order: 
Select Data from the main menu. 
Select Sort. The Sort dialog box will appear. 
Select the category you would like to Sort by. 
Select Ascending to sort in alphabetical order from A to Z. 
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Click OK. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

To sort in reverse alphabetical order from Z to A, select Descending. 
 

To Sort Multiple Categories: 
Select Data from the main menu. 
Select Sort. The Sort dialog box will appear. 
Select the category you would like to Sort by. 
Select Ascending to sort in alphabetical order from A to Z. 
In the Then by section, select the second category you would like to sort. 
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Click OK to sort in alphabetical order and by sales region. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Relative & Absolute Cell References 
Excel uses two types of cell references to create formulas. Each has its own purpose. Read on to 
determine which type of cell reference to use for your formula. 

 
Relative Cell References 
This is the most widely used type of cell reference in formulas. Relative cell references are basic 
cell references that adjust and change when copied or when using AutoFill. 
Example: 
=SUM(B5:B8), as shown below, changes to =SUM(C5:C8) when copied across to the next cell. 
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Absolute Cell References 
Situations arise in which the cell reference must remain the same when copied or when using 
AutoFill. Dollar signs are used to hold a column and/or row reference constant. 
Example: 
In the example below, when calculating commissions for sales staff, you would not want cell B10 
to change when copying the formula down. You want both the column and the row to remain 
the same to refer to that exact cell. By using $B$10 in the formula, neither changes when copied. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Microsoft PowerPoint 

Microsoft PowerPoint is a slide-based presentation program developed by Microsoft. It was 
officially launched on May 22, 1990, as a part of the Microsoft Office suite. 
Originally designed for the Macintosh computer, the initial release was called "Presenter", 
developed by Dennis Austin and Thomas Rudkin of Forethought, Inc.In 1987; it was renamed to 
"PowerPoint" due to problems with trademarks, 
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Versions: 
Versions for Microsoft Windows include: 

 1990 PowerPoint 2.0 for Windows 3.0

 1992 PowerPoint 3.0 for Windows 3.1

 1993 PowerPoint 4.0 (Office 4.x)
 1995 PowerPoint for Windows 95 (version 7.0; Office 95)
 1997 PowerPoint 97 (version 8.0; Office 97)
 1999 PowerPoint 2000 (version 9.0; Office 2000)
 2001 PowerPoint 2002 (version 10; Office XP)
 2003 Office PowerPoint 2003 (version 11; Office 2003)
 2007 Office PowerPoint 2007 (version 12; Office 2007)
 2010 PowerPoint 2010 (version 14; Office 2010)
 2013 PowerPoint 2013 (version 15; Office 2013)

 
Slide Masters and Templates 

Slide Masters are used to create consistent layouts throughout your presentation. Using masters 
you can format titles, backgrounds, colors, dates, times, and slide numbers. Changes made to the 
Master Slide and the Master Layouts are applied to all slides with that layout. 
Changing to the Slide Master View 
To edit the Slide Masters,  click  on  the View  tab and  click  the Master  Slide  button under  
the Presentation Views group. 

 
 
 

A Slide Master tab will appear next to the Home tab, and the slide sidebar on the left will 
display your presentation's Master Slide along with its accompanying layouts. 
To return to the normal view click on Close Master View. 

 
Modifying a Slide Master 
Once in the Master View, you can modify the Master Slides like any other slide. You can change 
the size and placement of placeholders, change the font, background, colors, etc. 
To change the theme and theme settings for your slide master use the options under the Edit 
Theme group, just as you would modify Theme settings from the Normal View. 

 
Adding & Deleting Layout Slides 
Different layouts will be available under the Master Slide depending on the Theme of your 
presentation. If you wish to add a new layout slide to an existing Master, either click the Insert 
Layout button in the Edit Master group or right-click in the slide sidebar and choose Insert 
Layout. A new slide will appear in the sidebar. 
To delete a layout, select the layout slide and either use the Delete button in the Edit Master 
group, or right-click the slide in the sidebar and select Delete Layout. 
Creating a New Slide Master Template 
To create a new template using Master Slides, either clicks the Insert Slide Master button in 
the Edit Master group, or right-click in the slide sidebar and choose Insert Master Slide. 

 
Saving a Slide Master as a Template 
To save your Master Slide and Layouts as a template: 

 Click on the Office button and choose Save As.
 In the File name box rename the template or keep the suggested name

 In the Save as type menu choose PowerPoint Template (*.potx)
 Click Save.
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Toolbars: 
Home Tab 
The Home tab includes basic functions for creating and manipulating a presentation. The 
toolbars that make up the Home tab include Clipboard, Slides, Font, Paragraph, Drawing, and 
Editing. 

 
Insert Tab 
Use the Insert tab to add a wide variety of content into a presentation including tables, charts, 
images, links, text boxes, audio, and video. 

 
Design Tab 
The Design tab provides a variety of options for designing and formatting a presentation. Use 
the Design tab to manipulate the page setup, color themes, and backgrounds of a presentation. 
The toolbars that make up the Design tab include Page Setup, Themes, and Background. 

 
Animations Tab 
Use the Animations tab to add, customize, and preview animations and transitions between 
slides. The toolbars that make up the Animations tab include Preview, Animations, and 
Transition to This Slide. 

 
Slide Show Tab 
Manage the settings for showing a presentation with the Slide Show tab. The toolbars that make 
up the Slide Show tab include Start Slide Show, Set Up, and Monitors. 

 
Review Tab 
The Review tab provides access to proofing features like spell check and also allows for 
embedding comments in a presentation. The toolbars that make up the Review tab include 
Proofing and Comments. 

 
View Tab 
The View tab presents a number of options to specify how to view a presentation such as hiding 
or displaying notes, hiding or displaying gridlines, zooming in and out, displaying in gray scale, 
and more. The toolbars that make up the View tab include Presentation Views, Show/Hide, 
Zoom, Color/Grayscale, Window, and Macros. 
Create a New Presentation 
To create a new presentation, click the Microsoft Office button and select New. The New 
Presentation pop-up window will appear. From here, choose to start with one of Microsoft’s 
Installed Templates, Installed Themes, or a Blank presentation to create a customized 
presentation. 

 
Design a Presentation 
PowerPoint includes a number of ready-made design themes. These themes serve as the basis 
for the graphic design of a presentation. Each theme consists of a background design, 
placeholder layouts, a color palette, and font styles. 

 
Insert a New Slide 
To insert a new slide into a presentation, click the Home tab in the ribbon. In the Slides toolbar, 
select the New Slide button. 

 
Save the Presentation 
To save a presentation, click the Microsoft Office button and choose Save As. 

View :- 
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The View buttons appear near the bottom of the screen. The diiffrent View options:- Normal 
view, Slider Sorter view, and the Slide Show view. 

Normal View 
Normal view splits your screen into three major sections: the Outline and Slides tabs,  
the Slide pane, and the Notes area. The Outline and Slides tabs are on the left side of  
your window. They enable you to shift between two different ways of viewing your 
slides. The Slides tab shows thumbnails of your slides. 

 
Slide Sorter View 

Slide Sorter view shows thumbnails of all your slides. In Slide Sorter view, you can easily 
add, delete, or change their order of your slides. 

 
Slide Show 

Use the Slide Show view when you want to view your slides, as they will look in your 
final presentation. 

 

Zoom:- 

Zoom allows you to zoom in and zoom out on the window. Zooming in 
means the window gets larger so you focus in on an object. Zooming out means the window gets 
smaller so you can see the entire window. 
Editing and Formatting Text:- 

 
To enter text: 

 Select the slide where you want the text 
 Click in a Textbox to add text 

To select the text: 
 Highlight the text by dragging the mouse. 

 
 

Copy and Paste 
To copy and paste data: 

 Select the text that you wish to copy 
 On the Clipboard Group of the Home Tab, click Copy 
 Select the text where you would like to copy the data 
 On the Clipboard Group of the Home Tab, click Paste 

To delete the text: 
 Highlight the text by dragging 
 Click delete. 

 
Formatting:- 
To format your text, first select it. Once the text you wish to format is highlighted, use the 
options in the Font and Paragraph groups under the Home tab to format your text. 

 
 
 
 

 
You can format a text box using the following:- 

 Ribbon 
 Quick Menu 

 
You can use formatting features to change the following:- 
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 To change the font typeface 
 To change the font size 
 Font Styles and Effects 
 Change Text Color 
 WordArt 
 Change Paragraph Alignment 
 Indent Paragraphs 
 Text Direction 

 
Find and select option: 
Find option is used to find the text within the presentation. Select option provides three options 
to select the text they are:- 
Select All 
Select Text 
Select Text With Similar Formatting Features 
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Bullets and Numbered list option:- 
Bulleted lists have bullet points, numbered lists have numbers, and outline lists combine 
numbers and letters depending on the organization of the list. 
To add a list to existing text: 

 Select the text you wish to make a list 
 Click the Bulleted or Numbered Lists button 

To create a new list: 
 Place your cursor where you want the list in the document 
 Click the Bulleted or Numbered Lists button 
 Start typing 

Nested Lists 
A nested list is list with several levels of indented text. To create a nested list: 

 Create your list following the directions above 
 Click the Increase or Decrease Indent button 

Header and Footer option 
 

To add a header and footer in your presentation:- 
Click on the Insert tab, then on the Header & Footer button. 
The Date & Time and Slide Number buttons will bring up the same dialog box. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
1. Fixed and Automatic Dates 
2. Slide Number 
3. Footer 
4. Apply/Apply To All 
5. Preview 
6. Notes and Handouts 

 
You can add the text in footer box. 

 
Paragraph Formatting 

 
To format your text, first select it. Once the text you wish to format is highlighted, use the 
options in the Font and Paragraph groups under the Home tab to format your text. 
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You can use paragraph formatting features to change the following:- 
 

Change Paragraph Alignment:- 
Choose the appropriate button for alignment on the Paragraph Group. 

 Align Left: the text is aligned with your left margin

 Center: The text is centered within your margins
 Align Right: Aligns text with the right margin

 Justify: Aligns text to both the left and right margins.
 

Indent Paragraphs 
 Click the Indent buttons to control the indent.
 Click the Indent button repeated times to increase the size of the indent.

 
Text Direction 

 Click the Text Direction button on the Home tab

 Click the selection

 
Spell Check 
To check the spelling in a presentation: 

 Click the Review tab 
 Click the Spelling button 

 
Print a Presentation 
There are many options for printing a presentation. They are: 

 Slides: The slides that you can, one slide per page 
 Handouts: 1, 2, 3, 4, 6 or 9 per page, in this option you can see more than one slide on 

one page. 
 Notes Page: This option contain the slides and the speaker notes. 
 Outline View: This will print the outline of the presentation. 

 

Inserting option in PowerPoint presentation:- 

Adding Picture 
To add a picture: 

 Click the Insert Tab 
 Click the Picture Button 
 Browse to the picture from your files 
 Click the name of the picture 
 Click insert 
 To move the graphic, click it and drag it to where you want it. 

Adding Clip Art 
To add Clip Art: 

 Click the Insert Tab 
 Click the Clip Art Button 
 Search for the clip art using the search Clip Art dialog box 

http://www.rccmindore.com/


45, Anurag Nagar, Behind Press Complex, Indore (M.P.) Ph.: 4262100, www.rccmindore.com 
57 

 

 

 Click the clip art 
 To move the graphic, click it and drag it to where you want it 

Editing Pictures and Clip Art 
when you add a graphic to the presentation, an additional Tab appears on the Ribbon. The 
Format Tab allows you to format the pictures and graphics. This tab has four groups: 

 Adjust 
Picture Style 

 Arrange 
 Size 

You can create your own simple shapes and objects with the built in drawing tools. You can 
even add formatting effects to your shapes, including resizing, rotating, 3D effects such as 
shadows and beveling, and changing the color of all or part of the shape. 
Drawing Preset Shapes 
In the Insert command tab, the Shapes group contains several 
categories of shapes, including lines, basic shapes, block arrows, 
flowchart elements, stars and banners, and callouts. 
Drawing Custom Shapes 
To draw your own shapes you can use the freehand drawing 
tools, Curve, Freeform and Scribble. 
Create a Chart 
To create a chart: 

 Click the Insert tab on the ribbon 
 Click the type of Chart you want to create 
 Insert the Data and Labels 

Edit Chart Data 
To edit chart data: 

 Click on the chart 
 Click Edit Data on the Design tab 
 Edit data in the spreadsheet 

Modify a Chart 
once you have created a chart you can do several things to modify the chart. 
To move the chart: 

 Click the Chart and Drag it another location on the same slide, or 
 Copy it to another slide 
 Choose the desired location and click Paste 

Slide Sorter 
The Slide Sorter is very useful feature, it help designer to check overall design of the 
presentation. 
Slide sorter feature are helpful to: 

 View slides as small thumbnails or miniature images
 Create animated transitions between slides
 Rearrange the order of the slides in your PowerPoint presentation

 Rehearse and set the timings of slide timings in your presentation

Slide Transitions 
Transitions are effects that are in place when you switch from one slide to the next. To add slide 
transitions: 

 Select the slide that you want to transition 
 Click the Animations tab 
 Choose the appropriate animation or click the Transition dialog box 

To adjust slide transitions: 
 Add sound by clicking the arrow next to Transition Sound 

Modify the transition speed by clicking the arrow next to Transition Speed 
To apply the transition to all slides: 

 Click the Apply to All button on the Animations tab 
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To select how to advance a slide: 
 Choose to Advance on Mouse Click, or 
 Automatically after a set number of seconds 

Slide Animation 
Slide animation effects are predefined special effects that you can add to objects on a slide. To 
apply an animation effect: 

 Select the object 
 Click the Animations tab on the Ribbon 
 Click Custom Animation 
 Click Add Effect 
 Choose the appropriate effect 

Animation Preview 
To preview the animation on a slide: 

 Click the Preview button on the Animations tab 
Slide Show Options 
The Slide Show tab of the ribbon contains many options for the slide show. These options 
include: 

 Preview the slide show from the beginning 
 Preview the slide show from the current slide 
 Set up Slide Show 

Set Up Slide Show 
This option allows you to set preferences for how the slide show will be presented. The options 
include: 

 Whether the show will run automatically or will be presented by a speaker 
 The looping options 
 Narration options 
 Monitor resolutions 

 

UNIT V 
Introduction: - the internet is a global network of interconnected computers, enabling users to 
share information along multiple channels. Typically a computer that connects to the internet 
can access information from a vast array of available servers and other computers by moving 
information from them to the computer’s local memory. 

 
Define internet 
From a social point of view – the internet is a device through which millions of people are 
communicating and sharing their idea and information. 

 
From a technical point of view – the internet is a network of thousands of computer networks. 
Together the networks making up the internet consist of over a mullion computer systems. 

 
Owner of internet: - the internet has no president nor has it a CEO the ultimate authority on the 
internet is the internet society, which is a voluntary membership organization whose purpose is 
to promote global information exchange through the internet technology. 

 
Application of internet:- 

1. Business on internet 
2. Governance on/through internet 
3. Crime on internet 
4. Educational training 
5. Research 

 
Advantages of internet: 

1. Information 
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2. Entertainment 
3. Services 
4. News 
5. E-commerce 
6. Communication 
7. Formation of communities 

 
Disadvantages: 

1. Spamming 
2. Theft of personal details 
3. Pornography 
4. Virus threat 
5. Waste of time and money 

 

World Wide Web (WWW): 
 

The World Wide Web is the universe of network-accessible information; an embodiment of 

human knowledge. In simple terms, The World Wide Web is a way of exchanging 

information between computers on the Internet, tying them together into a vast collection of 

interactive multimedia resources. World Wide Web is a series of servers that are 

interconnected through hypertext. Tim burner lee is widely known as the father of the World 

Wide Web. 

PROTOCOLS: - 
 

TCP/IP: - it stands for transmission control protocol/internet protocols. It is the 
communication protocols for communication between computers connected to the network 
specially internet.TCP/IP is divided into four layer 

 Network layer
 Transport layer
 Internet
 Application

HTTP (HYPER TEXT TRANSFER PROTOCOL) : - 
The HTTP provides a set of instructions for accurate information exchange. The communication 
between the client(your browser) and the server involvers request sent by the client and 
responses from the server. 
FTP (FILE TRANSFER PROTCOL) : – 
File transfer protocol is a network protocol used to exchange and manipulate files over as TCP 
computer network, such as the internet. An FTP client may connect to an FTP server to 
manipulate files on that server. 

 
INTERNET SERVICE PROVIDER (ISP):- 
A company that provides internet access is known as internet service provider. A ISP charge for 
its services. In general ISPs take two types of fees: 

 A charge for using the internet 
 A charge for a physical connection to the internet 

 
Use charges are billed at a fixed rate, ISPs do discriminate among classes of users. An ISP might 
provide dial up access, a cable connection, an ADSL connection or other types of internet access. 
In India there are more than 150 ISPs ( including BSNL, Airtel , etc) 

 
Kinds of connection 
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Dialup accounts: this is the slowest kind of connection currently available. Also your telephone 
line stays in use until you terminate the connection, implying that if your telephone bill is 
calculated according to the time of use. 

 
LEASED LINE: Uses fully digital signals over copper phone wire, a standard telephone line. This 
means there is no conversion from digital to analog and back again in manner that an analog 
modem works. 

 
VSAT: - 

 

very small aperture terminal, an earthbound station used in satellite communications of 

data, voice and video signals, excluding broadcast television. A VSAT consists of two parts, 

a transceiver that is placed outdoors in direct line of sight to the satellite and a device that is 

placed indoors to interface the transceiver with the end user‘s communications device, such 

as a PC. The transceiver receives or sends a signal to a satellite transponder in the sky. The 

satellite sends and receives signals from a ground station computer that acts as a hub for the 

system. Each end user is interconnected with the hub station via the satellite, forming a star 

topology. The hub controls the entire operation of the network. For one end user to 

communicate with another, each transmission has to first go to the hub station that then 

retransmits it via the satellite to the other end user‘s VSAT. 
 

Broadband: includes serveral transmission technologies, such as digital subscriber 
Line(DSL),cable , wireless ,satellite. 

 
URL (Uniform resource locator) :- URL is a type of uniform resource identifier that specifies 
where an identified resource is available and the mechanism for retrieving it. 
There are several parts to a URL. The first part of a URL defines a web protocol, such as the 
hypertext transfer protocol (HTTP) ,this part of URL(eg http://) allows the machines to talk to 
one another , the complete URL specifies the name of a server or a path to a web resource on a 
server, which a user can access by using browsers like Firefox, Opera , and Internet Explorer. 

 
Domain name systems(DNS): - 
It is an internet engineering task force(IETF) standard name service that allows your computer 
to register and resolve domain names. In other words DNS is a system that translates domain 
names into IP address. This is necessary because computers only make use of IP address yet we 
use only readable names since the name are easier to remember than IP address. 

 
Categories : - 

1. .com for commercial purpose like www.thinkdigital.com 
2. .edu for education domains like www.amity.edu 
3. .net for network, internet service provider and other network related companies like 

www.att.net 
4. .org for non government organization and non commercial like www.cry.org 
5. .mil for the united state military. 

Country level domain: - it is reserve for country. For example .in for India, .uk for united 
kingdom, .pk for Pakistan. 

 
PORTALS: 
A web portals is a site that functions as a point of access to information on the WWW. Portals 
present information from diverse sources in a unified way. Popular portals are MSN , Yahoo and 
AOL. 

 
ADVANTAGES: - 
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 Intelligent integration and access to enterprise content , applications and proceses. 
 Unified , real time access to information available in different systems. 

 
TYPES OF PORTALS: - 

 
 Regional portals 
 Government portals 
 Corporate portals 
 Entertainment portals 
 Investment portals 
 Shopping portals 

 

Email basic : 
Email is a method of exchanging digital messages , designed primarily for human use. A message 
at least consists of its content , an author address and one of more recipient addresses. The 
foundation for today’s global internet email service was created in the early Arpanet an was 
codified as a standard for encoding of messages , as RFC 733. 

 
Features of email : 

1. Address book 
2. Statistics 
3. Sorting or mails 
4. Security 
5. Edfit/draft option 
6. File attachment 
7. Reply/forward option 

 
Working of email – 
Email is based around the use of electronic mailboxes. When an email is sent, the message is 
routed from server to server, all the way to the recipient's email server.the message is sent to 
the mail server tasked with transporting emails (called the MTA, for Mail Transport Agent) to 
the recipient's MTA. On the Internet, MTAs communicate with one another using the protocol 
SMTP, and so are logically called SMTP servers (or sometimes outgoing mail servers). 
The recipient's MTA then delivers the email to the incoming mail server (called the MDA, for 
Mail Delivery Agent), which stores the email as it waits for the user to accept it. There are two 
main protocols used for retrieving email on an MDA: 
POP3 (Post Office Protocol), the older of the two, which is used for retrieving email and, in 
certain cases, leaving a copy of it on the server. 
IMAP (Internet Message Access Protocol), which is used for coordinating the status of emails 
(read, deleted, moved) across multiple email clients. With IMAP, a copy of every message is 
saved on the server, so that this synchronization task can be completed. To keep everyone from 
checking other users' emails, MDA is protected by a user name called a login and by a password. 
Retrieving mail is done using a software program called an MUA (Mail User Agent). When the 
MUA is a program installed on the user's system, it is called an email client (such as Mozilla 
Thunderbird, Microsoft Outlook, Eudora Mail, Incredimail or Lotus Notes). 

 
Types of email – 

1. Marketing Emails : - Marketing (or Bulk) emails stimulate your clients and leads. They 
contain informative / incentive messages. The recipient must agree to receive such 
emails: opt-in is mandatory. 
Examples : - Newsletters , Flash sales , Sales/promotions announcements 
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2. Notification Emails:- Notification email are also known as trigger, alert or auto- 
responder. They allow the user to be notified each time a particular event happens (or 
has happened). More generally, the notification email may be used in order to celebrate 
and/or mark an event. 
Examples: - getting in touch a few days after registration , Congratulations after a status 
change (first purchase, subscription...) , Birthday email , Shopping Cart Abandonment 
email 

3. Transactional Emails: - This is an expected message and its content is information that 
the client wishes to check or confirm, and not "discover". This type of email is not 
intended to optimize the customer relationship but to define it and mark it out. It is a 
point of reference in one’s CRM. 
Examples; - Welcome message / Account opening , Shipment tracking and order status , 
Order shipment confirmation , Account termination 

 
Free email sites are : - 

www.google.com 
www.yahoo.com 
www.rediff.com 
www.indiatimes.com 
www.mail.com 
www.inbox.com 

 

Simple Mail Transfer Protocol (SMTP) :- 
The Simple Mail Transfer Protocol (SMTP) service, which transfers e-mail, is installed as part of 
E-mail Services, along with the POP3 service. 

 
SMTP controls how e-mail is transported and then delivered across the Internet to the 
destination server. The SMTP service sends and receives e-mail between servers, whereas the 
POP3 service retrieves e-mail from the mail server to the user's computer. For more 
information, see the SMTP documentation Microsoft SMTP Service. 

 
Pop3(post office protocol) : - the post office protocol is an application layer protocol used by 
local email client s to retrive email from a remote server ovr a TCP/IP connection. The POP 
protocol has been devoloped through serveral versions. With version 3 being the current 
standard .like IMAP , POP3 is supported by most webmail services such as hotmail, gmail. And 
yahoo mail. 

 
Virus :- 
A computer virus is a program or piece of code that is loaded onto your computer without you 
knowledge an runs against your wishes. All computer virus are man made. 
A few prominent virus are Michelangelo, dishwasher, C-brain , macmag , nenusalem , columbus 
etc. 

 
How a virus spread : 

1. Using a paired device 
2. Through network system 
3. Through secondary storage devices 
4. Through internet 

Types of computer virus : - 
1. Boot sector virus - these types of viruses get themselves stored in th boot sector of 

floopy and hard disk. When we boot a computer system it hinders the loading of 
oprating system. 
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2. Partition table virus – these kind of viruses affect the partition table of hard disk but 
do not affect the data in the computer.it only affects MBR(master boot record) of the 
hard disk. 

3. File virus- this kind of virus get associated with executable files. When an EXE file is 
executed , virus may executes to affect the computer system. 

4. Stealth virus – a stealth virus is a computer virus that makes every effort to conceal 
its presence from the user. 

5. Polymorphic virus – a polymorphic virus is one that is capable of changing itself so 
that each infection of the virus is completely different from the original. 

6. Macro virus – a macro virus is a virus specially meant to infect specific type of file 
such as document file and spreadsheet file. 

 
Antivirus : - a utility software that searches a hard disk for viruses and removes any that are 
found. Most antivirus programs include an auto update feature that enables the program to 
download profiles of nes virus so that it can check for the new viruses as soon as they are 
discovered. 
Some popular antivirus are NPAV, Quick heal ,Avast and Mac fee etc. 

 
Internet browsers: 

Internet browser or web browser are softwares that allow you to explore the net. These 
are actually client programs and are capable to display and interact with hypertext 
document. These softwares are especially designed for the web use. 
There are two types of browsers text based browser and graphical browser. Graphical 
browser supports multimedia like text, video, animation, audio etc. 
Some popular browsers are – 
 Microsoft Internet Explorer 
 Netscape Navigator 
 Mozila Firefox 
 Google Chrome 
 Opera 
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